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Project Summary Specification � Practice Manager v8.7 
SP3 
 

1. External References 

Pending acceptance of the Project Summary Specification (PSS) the following documents will be generated 
as dictated by the Unified Document Strategy  (UDS) followed by RealLegal, LLC. 

 

Title Files can be found in… Author Date 

Sign-off and Checklist for Practice Manager v8.7 SP3 See page C. Tom Foley 03/04/2003 

Functional Requirement Specification for Practice 
Manager v8.7 SP3 

Not applicable. N/A N/A 

Functional Design Specification for Practice Manager 
v8.7 SP3 

Not applicable. N/A N/A 

Technical Design Specification for Practice Manager v8.7 
SP3 

Not applicable. N/A N/A 

Technical Design Specification for the Practice Manager 
v8.7 SP3 Data Model. 

Not applicable. N/A N/A 

Test Plans for the Practice Manager v8.7 SP3 http://pm.reallegal.com/reallegal/dow
nload/pm/pm_v87sp2/kx/testplans/ 

QA  

Development Schedule for the Practice Manager v8.7 
SP3 

Included in the development 
schedule (see 
http://pm.reallegal.com/reallegal/dow
nload/rd/schedules/current_developm
ent_scheduled.html) 

Tom Foley Updated 
Weekly 

Turnover documents http://pm.reallegal.com/reallegal/dow
nload/pm/pm_v87sp2/kx/turnover/ 

Saulius  

Lead Problem Report for the Practice Manager v8.7 SP3 http://iowa.pmt.lt/bugs/scripts/BugListi
ng.asp?UPD=0&RESPONSIBLEID=-
1&LOGIN=&APPLICATIONID=72&W
HERE=report.APPLICATIONID%20
%3D%2072%20&ORDER=Status%2
C%20Areas%2C%20Type%2C%20R
eportID 
 
http://thunder/bugs/scripts/BugListing.
asp?UPD=0&RESPONSIBLEID=-
1&LOGIN=&APPLICATIONID=72&W
HERE=report.APPLICATIONID%20
%3D%2072%20&ORDER=Status%2
C%20Areas%2C%20Type%2C%20R
eportID 

QA Updated 
Constantly 

Meeting Minutes for the Practice Manager v8.7 SP3 http://pm.reallegal.com/reallegal/dow
nload/pm/pm_v87sp2/kx/other/ 

Tom Foley  
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Title Files can be found in… Author Date 

User Manual for the Practice Manager v8.7 SP3 http://pm.reallegal.com/reallegal/dow
nload/pm/pm_v87sp2/kx/doc&help/ 

TechComm  

Install Guide for the Practice Manager v8.7 SP3 http://pm.reallegal.com/reallegal/dow
nload/pm/pm_v87sp2/kx/doc&help/ 

Tom Foley  

Practice Manager v8.7 SP3 Beta Screenshots for 
Marketing 

Not applicable. N/A N/A 

Project Post-Mortem for the Practice Manager v8.7 SP3 http://pm.reallegal.com/reallegal/dow
nload/pm/pm_v87sp2/kx/other/ 

  

Release Page http://pm.reallegal.com/reallegal/hom
e/pm/pm_v87sp3.htm 

Tom Foley Last Update: 
03/04/2003 

 

2. Definition of Terms 

The definition of terms from this document are outlined below. 
 

Term Definition 

FRS / Functional Requirement Specification Generated by Product Management; outlines requirements for the 
product covering one or more releases in order to steer the product in a 
given direction.   

PSS / Project Summary Specification Generated by Program Management to provide a summary of the plan, 
resources, and costs that will be included in each phase of the project. 

FDS / Functional Design Specification A living document generated by Program Management.  It details the 
functionality, interfaces, and use cases of the program for each release 
of the program. 

TDS / Technical Design Specification A living document generated by a Technical Analyst that is carried from 
one release to the next.  Details the technical decisions that are made 
including the technical architecture of the program and its associated 
data model. 

Product A product describes the deliverables of project including the 
executables, installations, documentation, marketing material, support 
plans, and other material. 

Program A program describes the deliverables of one or more projects within the 
development group including code, executables, installations, user 
manuals, install guides, and test plans. 

Project A project consists of a well-defined collection of small jobs (tasks) and 
culminates in a finished product.  A project is temporary in nature 
meaning it has a specific start and finish. 
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3. PSS Introduction 

The Project Summary Specification (PSS) is a document based on the Functional Requirement Specification 
(FRS) and contains the following: 

Ø A summary of the project goals and objectives, major work activities, and major milestones.  

Ø An estimate of the resources and costs involved in seeing the project to its final completion. 

Ø If applicable, a summary of the project's relation to the strategic goals of RealLegal. 

Ø If applicable, the long-term strategic plan set in place for the program including its immediate short-term 
release phases and long-term release schedule. 

Ø A risk management analysis to identify potential risk and mitigate the risk to ensure success of the 
project. 

The accepted (PSS) leads to the development of the Functional Design Specification (FDS) and eventually to 
the Technical Design Specification (TDS). 
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4. Project Overview 

Corazon SP1, SP2, SP2A and SP3 are Service Pack releases for RealLegal Practice Manager version 8.7, originally developed under the 
Project Codename of Salado. 

The following is a summary of counts, by Application Area, of PCRs that will be addressed in this release. 
 

Rvw Hold Pending N/A Deferred Done Final Totals 
Name 

B T B T B F U I T B F U I T B F U I T B F U I T B F U I T B F U I T 

Bar Numbers     1    1                     1    1 
Components     1    1      2  1  3           3  1  4 
Database                       1 1         1 1 
Desktop Views               1    1         1 1 1   1 2 
Document Assembly     4    4      1    1 2  1 1 4    1 1 7  1 2 10 
Document Assembly Merge     5    5           5    5      10    10 
Document Assembly Settings     1    1      3    3           4    4 
Document DE     5    5      2 1 1  4 1   1 2      8 1 1 1 11 
Document Listing     1    1      2    2         1 1 3   1 4 
Document Settings     1    1                     1    1 
Documentation/Manuals/Help       1  1        1  1   2  2        4  4 
Entity DE 1 1   10    10      3    3           14    14 
Entity Listing     1  1  2      1    1           2  1  3 
Entity Settings     1    1      2  1  3           3  1  4 
Filter     3    3                     3    3 
General       1  1      1    1           1  1  2 
Groupware DE     5  1  6      1    1           6  1  7 
Groupware Listing     1    1                     1    1 
Groupware Listing Query                 1  1             1  1 
Guideline               1    1           1    1 
Help       1  1                       1  1 
Imageview     4    4      9    9           13    13 
Install/ Upgrade     6  4  10 1    1        2  2      7  6  13 
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Rvw Hold Pending N/A Deferred Done Final Totals 
Name 

B T B T B F U I T B F U I T B F U I T B F U I T B F U I T B F U I T 

Mail Merge               2    2           2    2 
Matter DE     3    3       1   1           3 1   4 
Matter Listing   1 1 3    3                     4    4 
Matter:Annotations       1  1                       1  1 
Matter:Issues               1  1  2           1  1  2 
Matter:Tree View       1  1                       1  1 
Matter:Workflow                     1   1       1   1 
Note DE     2    2                     2    2 
Note Listing       1  1                       1  1 
Note Settings     1    1                     1    1 
Phone Call DE               1    1           1    1 
Printing     1  1  2                     1  1  2 
Query               1    1           1    1 
Security Settings       2  2                       2  2 
Site Settings       2  2                       2  2 
Source Code     1 1   2                     1 1   2 
System Settings       1  1   1  1 3    3           3  2  5 
TiffView     3    3      7    7   1  1      10  1  11 
Timeslip DE     1    1                     1    1 
Timeslip Listing     1    1             1  1      1  1  2 
Utility     1    1             1  1      1  1  2 
Workflow DE   1 1 3 1   4                     4 1   5 
Workflow Listing     1  1  2              1 1      1  1 1 3 
Workflow Settings               2    2           2    2 
Total 1 1 2 2 71 2 19  92 1  1  2 46 2 6  54 8 1 8 4 21    3 3 129 5 34 7 175 
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5. Project History (Builds) 

See http://pm.reallegal.com/reallegal/download/pm/pm_v87sp2/kx/turnover/. 
 

6. Scope – Inclusions 

This report is taken from the PCR Database.  It is all PCRs in SP3 that, as of March 04, had a status of Pending, Done or Final .  This list is 
subject to update, and the PCR Database always represents the latest and greatest version of this report. 

The report is first sorted by Status, then Area, then Type and finally by ID. 

There are additional fields available when this report is accessed from the PCR Database.  Note that the links currently point to Thunder.  This 
is only available if you connect to the PCR Database from the Lithuanian office or from the VPN.  At the time this report was generated, there 
as no quick way to correct this.  Future updates should have this corrected. 

 

Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

Pending Bar Numbers Bug 14259 Date of Admission field on the Bar 
Number screen should have the same 
mask, as DOB (Or DOD) field on the 
Other Details of Entity DE 
Comments: It seems like this filed doesn’t 
have the same mask, as DOB (Or DOD) 
field on the Other Details of Entity DE. If I 
click within DOB field, it has __/__/__ 
mask (regardless of Date/Time format 
settings in the System Settings). But if I 
click within Date of Admission field, it 
doesn’t have any mask, and unless I enter 
date with correct format, I will get “..is not 
a valid date” message. 

8.7.40.1    Mike G    2/17/03 
10:08:29 

AM  

Pending Components Bug 14501 Receiving message “Warning, YOUR 
connection to the database dropped” 
when attempting to set a Default Filter in 
Matter Settings 

8.7.40.1 AmFam  Mike G Feedback  2/26/03 
2:32:17 PM 

Pending Document 
Assembly 

Bug 12343 Merge with Word2000. When multiple 
documents are opened and generate one 
more document (use doc assembly 

8.7.31.1    Rasa    11/14/02  
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Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

template), then this just generated 
document does not come to the front. I 
have to click on it on the title bar. 
Comments: For example: There is already 
a document (ex. 111.doc) opened. Merge 
one more document (112.doc) and use 
doc assembly template . After merge 
112.doc does not come to the front. 
This happens just when creating 
document with dos assm template. When 
opening documens or create blank 
document works correct. 
The same with WordXP, when is checked 
'Windows in Taskbar'. 
[TAF 01/15/2003] At the very least, we 
need a full understanding as to why this 
can or cannot work, and what it would 
take to make it work? 
[TAF 01/23/2003] There is not enough 
time in SP2 to get this coded and properly 
tested. It is potentially a high-risk fix, and 
a behavior that can be observed in Word 
when used outside of PM. Please note 
that part of the reason we did not have 
time to address this PCR in SP2 is 
because other PCRs, namely those 
involving AMFAM and Saga, were 
received late in the development cycle 
and superceded this one with respect to 
resource allocation 

Pending Document 
Assembly 

Bug 13946 In PM, create document profile, create 
document. Edit it save, then exit. Here WP 
exits but it also shuts PM down instantly. 
Comments: In PM, create document 
profile, create document. Edit it save, then 
exit. If you are creating a document using 
assembly, then after 2 or 3 documents the 
above will occur. If you skip document 

8.6.35.4 Dalan & Katz - 
031.Ticket 

25405  

Ken F; Mike 
G 

25405  1/30/03 
4:31:07 PM 
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Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

assembly, you can create as many 
documents as you like. No error 
messages occur. 
Word Processor Version: WP 8.0.0.710 
Client says he having this problem since 
September 

Pending Document 
Assembly 

Bug 14448 Receiving “The server threw an exception” 
message, when creating a document. 
Also, the same message received when 
"Entering info in PM8" 

8.7.40.1 AmFam  Mike G, Ken 
F 

Feedback  2/25/03 
3:42:52 PM 

Pending Document 
Assembly 

Bug 14495 Receiving message"The server threw an 
exception" when creating and changing 
documents 
Comments: Same problem reported by 
AmFam (PCR 14448 in SP3) 
2. Trying to open a new document - 
Homestead Declaration; Editing 
documents from other PM files 

8.7.40.1 Bacon & Wilson Mike G Feedback  2/26/03 
1:45:19 PM 

Pending Document 
Assembly Merge 

Bug 13561 When merge document get an error 
'Could not find WLL window to 
communicate with Ms Word' 
Comments: There are installed Word 
2000 on PC. Create new document, select 
Application=Word97, merge a document, 
MS Word window is opend and have got 
an 'Word CAPI' error 'Error-1'. Click OK 
and close Word screen. In Profile de 
change the application to Word2000 and 
merge document. When the document is 
merged (all PM field are retrieved), have 
got an 'PM to Word 97 Merge' error. 
[TAF 01/19/2003] We need to check and 
make sure the template uses an 
application that is installed. If the 
application is installed, then proceed with 
the merge. If not, display an error 

8.7    Rasa    1/18/03 
1:29:37 PM 
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Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

message: 
"The document merge could not be 
completed because the selected 
application is not installed on this 
workstation. [OK]"  
PCR 11015 addresses the checking of all 
components involved in the merge to 
make sure they are of the same 
application family, throwing an error if they 
are not. This prevents the user from 
carrying out a merge with both Word and 
WordPerfect components selected. Right 
now, I believe we only make sure the 
template and boilerplate are of the same 
engine when selected. The Letterhead, 
Caption and COS could actually be of 
different engines 

Pending Document 
Assembly Merge 

Bug 13643 When merge a document and have got 
message that letterhead (boilerplate...) 
does not exist, hit on any place in PM 
(e.g. on Save, Cancel buttons), the 
message hidden behind the PM screen. 
Maybe should be better, that this 
message should be always on top? 

8.7    Rasa    1/19/03 
5:55:10 PM 

Pending Document 
Assembly Merge 

Bug 13808 When the first time click on Generate a 
document have got 'The conversion of a 
char data type to a datetime data type 
resulted in an out-of-range datetime 
value'. Click the second time, document is 
merged. 
Comments: For example: Create new 
document. Select doc assm components 
(in FRM file of this components exist field, 
which is not assigned in Document 
Component Design DE form). Click on 
Generate document. Have got an error. 
OK. Click the second time Generate 

8.7.39.1    Rasa    1/24/03 
7:35:28 PM 
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Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

Document. Document is merged. 
I try the same situation on another DB 
(db=pm87_sql7_qa1), works correct. 
 
This happens if users Default Language in 
SQL Server is British English. 

Pending Document 
Assembly Merge 

Bug 14310 When generate some documents with doc 
assm templates, get access violation. 
Comments: Word Processor Version: WP 
8.0. Generate document with doc assm 
template (this template has some PM 
fields and keybord fields). Document is 
generated. Then generate one more 
document with the same template. After 2 
or 3 documents, get access violation 
(attached screenshot). 
 
Also I get the same error, when after 
document merge, go to Document 
Assembly Settings, create new 
component, enter Description, assign 
some fields, select Engine and then hit on 
FileName cowboy hat button. 

8.7.40.1    Rasa    2/19/03 
2:28:43 PM 

Pending Document 
Assembly Merge 

Bug 14312 Word Processor: WP 9.0. Merge 
document with Doc Assm Template (it has 
some keyboard fields). When Corel 
application opens the merge process is 
not executing (Merge Message screen 
displayed, you cannot enter anything, 
cannot Close Corel application) 
Comments: Tested on Citix 

8.7.40.1    Rasa    2/19/03 
2:45:26 PM 

Pending Document 
Assembly 
Settings 

Bug 13718 Filter 'Assignments to show… All' in 
Assignment tab has to show Global and 
Author-Specific component assignments, 
not all assignments of Law category, Law 
Type, etc 

8.7.38.1    Abe    1/22/03 
6:11:35 PM 
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Pending Document DE Bug 13386 When using Pmpaper.exe a 40 or 50mb 
file will cause the app to stop running 
Comments: When scanning file over 150 
pages pmpaper dies 
Pmpaper.exe 
Paperport version 7.0 

8.6.35 Stephanie J. 
Stevenson, P.C. 

Josh Berlin 24333  1/15/03 
11:28:17 

AM  

Pending Document DE Bug 13455 Error when creating document 
Comments: [Bacon&Wilson] Every time 
this person tries to create a new 
document, she gets this error. No 
document is created. I have tried re-
installing the client, and re-installing 
MDAC - neither option worked. The macro 
settings are set to low, and VB objects are 
trusted sources 
Message: 
This file could not be found. 
Try one of the following: 
*Check the spelling of the name of 
document 
*Try a different file name 
[NFI] Behaves the same whether in citrix 
or not. 

8.7.33.2 Bacon&Wilson  Steve 
Adams 

23422  1/16/03 
1:10:13 PM 

Pending Document DE Bug 14442 Error message "External exception 
C0000006" when clicked on Caption 
button in Document DE 

8.7.40.1 AmFam  Mike G; Ken 
F 

Feedback  2/25/03 
3:06:55 PM 

Pending Document DE Bug 14485 Error message "The column prefix 
'ENTTYPE' does not match with a table 
name or alias name used in the query" 
when going to Entities tab in Document 
DE 

8.7.40.1 AmFam  Krebs-Otto, 
Rita J 

Feedback  2/26/03 
5:11:25 PM 

Pending Document DE Bug 14538 Receiving Message “One or more items in 
the folder you synchronized do not match. 
To resolve the conflicts, open the items, 
and then try this operation again” when 

8.7.40.1 AmFam  Mike G Feedback  2/27/03 
3:24:05 PM 
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entering a hearing 

Pending Document Listing Bug 14386 If you remove Primary Matter No column 
from the listing and save Grid layout, after 
closing and reopening PM column still 
displayed. 
Comments: Both Doc Global and 
Matter:Doc listings 

8.7.40.3 Summer S  Mike G    2/21/03 
12:25:22 

PM  

Pending Document 
Settings 

Bug 13688 Tab order is incorrect in Document 
Template DE 
Comments: Tab order is:  
1. Edit 'Template Code' 
2. Checkbox 'Public Template' 
3. Edit 'Description' 
 
Should be 
1. Edit 'Template Code' 
2. Edit 'Description' 
3. Checkbox 'Public Template' 

8.7    DK    1/21/03 
4:28:33 PM 

Pending Documentation/M
anuals/Help 

Update 14482 Update TO with info regarding 
<PMROOT>\KOFAX_INS directory - see 
14410 

8.7.40.4    Donatas    2/26/03 
3:44:42 PM 

Pending Entity DE Bug 14300 Access Violation when checking on an 
entity for a phone number. 
Comments: Access violation at address 
007ED65E in module 'PMWIN.exe'. Write 
of address 000000E0 

8.7.40.1 Bacon&Wilson  Alice D. 
Delorme 

Feedback  2/19/03 
10:40:58 

AM  

Pending Entity DE Bug 14328 Error "Invalid column name 
'MEDCAREPRID'" when cancelling the 
"adding" of an entity (adding a party) 

8.7.40.1    McRae 
Huszagh 

Feedback  2/20/03 
12:19:01 

PM  

Pending Entity DE Bug 14450 Receiving “Warning, YOUR connection to 
the database dropped” Message ,when 
GOING FROM GENERAL TAB TO 
OTHER DETAILS IN AN ENTITY. 

8.7.40.1 AmFam  Mike G, Ken 
F 

Feedback  2/25/03 
3:49:43 PM 



Printed: 03/04/2003  Last Updated: 03/04/2003 
 RealLegal, LLC Confidential and Proprietary Information 
 Project Summary Specification � Practice Manager v8.7 SP3 

C:\Documents and Settings\TFOLEY\My Documents\rl.stuff\dev\pm_core\andes\pm87sp3\specs\pm87sp3_pss_v0100.doc  
Copyright © 1992-2003 RealLegal, LLC, Rev. No. 22 Scope – Inclusions l 14 

Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

Pending Entity DE Bug 14503 Receiving message “A component named 
frmEntityInfo already exists” when trying 
to look at an address of an already 
assigned entity 

8.7.40.1 AmFam  Mike G Feedback  2/26/03 
3:51:48 PM 

Pending Entity DE Bug 14523 Access violation when going from the 
assign screen to the detail screen - where 
we put in the date of birth and SS# 
Comments: Access violation at address 
007F8AE3 in module 'PMWIN.exe'. Read 
of address 00000008 
This error also received when "when 
Trying to get to the "other details" screen 
on an entity" 

8.7.40.1 AmFam  Swenson, 
Angela J 

Feedback  2/27/03 
2:18:25 PM 

Pending Entity DE Bug 14530 Access Violation when attempting to open 
an entity to make modifications 
Comments: Access violation at address 
007ED65E in module 'PMWIN.exe'. Write 
of address 000000E0 

8.7.40.1 AmFam  Conover, 
Sarah J 

Feedback  2/27/03 
4:49:17 PM 

Pending Entity DE Bug 14536 Received "Access violation at address 
007F8AE3 in module 'pmwin.exe'. Read 
of address 00000008" error when 
switching from general to other details tab 
in entities 

8.7.40.1 Wilkes & 
McHugh  

Mike G Feedback  2/27/03 
2:55:31 PM 

Pending Entity DE Bug 14540 Receiving "Access violation at address 
007ED65E in module 'PMWIN.exe'. Write 
of address 000000E0" when Opening 
Address on Entity 

8.7.40.1 AmFam  Mike G Feedback  2/27/03 
3:34:13 PM 

Pending Entity DE Bug 14550 Receiving Message “A component named 
frmEntityInfo already exists” when in 
entities 

8.7.40.1 Wilkes & 
McHugh  

Mike G Feedback  2/27/03 
4:49:27 PM 

Pending Entity DE Bug 14604 Receive "Access violation at address 
007ED65E in module 'PMWIN.exe" error 
when Attempting to add Matter Related 

8.7.40.1 AmFam  Mike G Feedback  3/3/03 
3:36:13 PM 



Printed: 03/04/2003  Last Updated: 03/04/2003 
 RealLegal, LLC Confidential and Proprietary Information 
 Project Summary Specification � Practice Manager v8.7 SP3 

C:\Documents and Settings\TFOLEY\My Documents\rl.stuff\dev\pm_core\andes\pm87sp3\specs\pm87sp3_pss_v0100.doc  
Copyright © 1992-2003 RealLegal, LLC, Rev. No. 22 Scope – Inclusions l 15 

Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

Party's date of birth 

Pending Entity Listing Bug 14602 Receive Message "Warning, YOUR 
connection to the database dropped" 
when going to Edit Preferences from 
Related Tree of Entity 

8.7.40.1 AmFam  Mike G Feedback  3/3/03 
3:26:38 PM 

Pending Entity Listing Update 14384 Ability to "Save Grid Layout" in "Related 
Matters" dialog box (this one is really 
important, particularly if used as part of 
conflicts checking) 
Comments: [Cynthia Kutka 2/21/03] I think 
it should be considered for SP3 
depending on how difficult and time-
consuming it is to implement. It is not 
important enough to delay the release of 
SP3. 

8.7.40.1 Shriners  Mike G    2/21/03 
9:28:28 AM 

Pending Entity Settings Bug 14446 Receive “Warning, YOUR connection to 
the database dropped” message, when 
working in the Entities settings. 

8.7.40.1 AmFam  Mike G; Ken 
F 

Feedback  2/25/03 
3:30:55 PM 

Pending Filter Bug 13754 Remove mask from Entity Filter All 
Phone#s field. Add support of wildcards 
Comments: International format is 
disabled. Right now you have to enter all 
10 digits, otherwise you cannot apply this 
filter. 

8.7.38.1    Mike G    1/22/03 
4:13:58 PM 

Pending Filter Bug 13916 Groupware global listing filter: Sent Date 
To, Start Date To, Due Date To, Event 
Date To-Date From fields do not work 
properly 
Comments: 1. Sent Date To: I set it to 
01/20/03 but returned results exclude this 
date. Returned results should include 
01/20/03. The same problem also found 
on Note global listing filter. 
2.Start Date To has the same problem 
3. Due Date To has the same problem 

8.7.39.1    Mike G    1/29/03 
1:58:01 PM 
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4. Event Date To-Date From are not 
respected at all 

Pending Filter Bug 14597 On Reschedule Event screen, "By" faucet 
filter doesn’t have right-click option Filter 
Field. 
Comments: On Workflow item DE click 
Reschedule->on Reschedule Event 
screen right-click on “By” faucet filter. 

8.7.40.4    Mike G    3/3/03 
12:29:08 

PM  

Pending General Update 14204 Remove the Files\ subfolder from the 
turnover file set. The only folders that 
should be included are the Install, 
Upgrade and KX folders 
Comments: [PMT\tom 3/4/03] Note that 
we will still create the Files\ folder in 
Lithuania, we just won't upload it or 
reference it in the turnover document. 

8.7    TF    2/13/03 
9:22:28 AM 

Pending Groupware DE Bug 14454 Receiving “Warning, YOUR connection to 
the database dropped” message, when in 
creating a new task in Groupware. Also, 
receiving the same message when 
"Creating a groupware message" 

8.7.40.1 AmFam  Mike G, Ken 
F 

Feedback  2/25/03 
4:29:15 PM 

Pending Groupware DE Bug 14544 Receiving Message “One or more items in 
the folder you synchronized do not match. 
To resolve the conflicts, open the items, 
and then try this operation again” when 
SENDING APPT IN PM GROUPWARE 
TO OUTLOOK SENDS APPT TO 
OUTLOOK NOT SAVED IN 
GROUPWARE 
Comments: Also, when Sending Appt to 
myself. Also updating a date in 
Groupware. Also, when entering a date 
(meeting) and time. Also, Sending Appt 
through Groupware to Outlook Appt is in 
Outlook and not in Groupware. Also, 

8.7.40.1 AmFam  Mike G Feedback  2/27/03 
4:06:08 PM 
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Sending Appointment Outlook- 
Appointment appears in Outlook but not 
saved in Groupware. 

Pending Groupware DE Bug 14546 Receiving Message “Description>Cannot 
resolve recipient – To” when sending an 
appintment through Groupware 

8.7.40.1 Fuller, Johnson 
& Farrell  

Mike G Feedback  2/27/03 
4:21:09 PM 

Pending Groupware DE Bug 14606 Receive "Warning, YOUR connection to 
the database dropped" when Trying to 
send a note by e-mail 

8.7.40.1 AmFam  Mike G Feedback  3/3/03 
3:47:55 PM 

Pending Groupware DE Bug 14645 Error message "Exception occurred: 
External exception C0000006" when drag 
incoming mail into a matter 

8.7.40.1 AmFam  Long, 
Gwendolyn 

K 

Feedback  3/4/03 
5:40:47 PM 

Pending Groupware DE Update 13964 Sending Groupware from Note DE does 
not supports System Setting "Use 
ClientNumber.MatterNumber" in Subject 

8.7.40.1    Donatas    1/31/03 
3:00:12 PM 

Pending Groupware Listing Bug 14573 Receive Message "Warning, YOUR 
connection to the database dropped" 
when Checking email coming in - 
recorded statement from WDM word 
processing 

8.7.40.1 AmFam  Mike G Feedback  2/28/03 
10:18:04 

AM  

Pending Help Update 14617 Remove the links to the User's Guide and 
Administrator's Guide from the Help menu 
and Start menu. Also remove pm.ag.pdf 
and pm.ug.pdf from the file set 

8.7.40.4    TF    3/4/03 
10:05:01 

AM  

Pending Imageview Bug 13545 Out of memory error using TextBridge 
OCR: 
Comments: Lisa has encountered this 
error during her testing of the OCR. I have 
yet to replicate the error. 
Symptoms: When the TextBridge 
application is launched from the OCR 
window of ImageView, this error occurs. 
Action: We have no plan for resolving this 

8.4.35.2 Amfam  Ken    1/17/03 
5:12:59 PM 
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problem at this time; this letter is the first 
opportunity we have had to inform 
RealLegal of the issue. We have only very 
recently uncovered this problem.  
Status: The ImageView program can be 
divorced from the 8.7 rollout and we can 
continue to use the Kodak Image Viewer 
until the issue is resolved, so the risk is 
low. Our desire for the OCR feature is 
extreme, so the impact of this issue is also 
of the highest nature. 

Pending Imageview Bug 13829 In Window menu displayed not all of 
document's pages and order of pages is 
incorrect. 
Comments: Open multipage image with 
Image Viewer (for example there are 11 
pages). Go to Window menu, you see just 
4 pages. Clicking arrow button go to next 
pages. Again go to Window menu, now 
you see more pages.  
Also the pages are not ordered (the firs 
displayed 'page #4', 'page #3', 'page #2', 
'page #1', 'page #5', ….) 

8.7.0.24    Rasa    1/27/03 
1:36:35 PM 

Pending Imageview Bug 14102 I just noticed that there is still logo and 
company name of law.com on the left side 
of %subj%. PM version is 8.7 SP2A. 
Comments: [PMT\tom 3/4/03] New 
bitmaps are available in 
\\Ltdevsql1\D\QA\builds\pm\pm_v87sp3\k
x\specs\pm.bitmaps\. Let me know if you 
need anything else for this. 

8.7.0.24    Audrius    2/10/03 
5:13:30 PM 

Pending Imageview Bug 14516 When close ImageViewer window, have 
got an error. 
Comments: Open document with 
ImageViewer (this document has 11 
pages). In Page menu> Visible Pages is 

8.7.0.24    Rasa    2/27/03 
1:08:47 PM 
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set 20 pages. With Next Page button go to 
the last page. Then from Page> Visible 
Pages set 5 pages, OK. Close Image 
Viewer. Have got ant error 'List index out 
of bounds (0)' 

Pending Install/ Upgrade Bug 13975 When I select to install HotDocs, in Doc 
settings>Application Hot docs should 
assemble witth the default WP I selected 
during install. 
Comments: During Install I set Word XP 
as the default WP with no additional WP. 
When I went to Doc Settings>Application 
Hotdocts Automator was set to assemble 
with Word 97. Also HOTDOCTS should 
be spelled HOTDOCS 
[PMT\tom 3/4/03] The HotDocs Automator 
should be configured for whatever Word 
Processor is selected as the default 
during install. 

8.7    Ken    1/31/03 
5:03:36 PM 

Pending Install/ Upgrade Bug 14081 This happens right after install (being run 
on the file server MPPMFS01) asks for 
login to the SQL Server. I have selected 
MPSQL02, SA, blank password 
Comments: Same happens when trying to 
use NT Authentication. 
Same happened when I tried to use 
MUMBO-JUMBO for login. :-) 
This problem was worked around by 
running on the SQL Server box 
(MPSQL02) 
[TF 02/28/2003] If the install or upgrade 
cannot proceed with the SQL portion, it 
needs to just place all SQL files in a folder 
and proceed with the file set portion of the 
install/upgrade. A message needs to 
display advising the user that this is the 
case 

8.7.40.1    Gedas    2/10/03 
3:26:26 PM 
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Pending Install/ Upgrade Bug 14085 Running client install on the Citrix server 
MPCTX-01 crashed the OS 

8.7.40.1    Gedas    2/10/03 
3:26:26 PM 

Pending Install/ Upgrade Bug 14185 Install PM 8.6.35, upgrade it to 8.7.40 and 
run uninstall > initial Uninstall window 
talks about PM 8.6 (for both - client and 
network server). 

8.7.40.1    Arunas    2/12/03 
4:37:40 PM 

Pending Install/ Upgrade Bug 14209 In PM 8.0.75.1 select International Format 
checkbox in System Settings. Upgrade 
PM to 8.7.40.1 - International Format 
checkbox is no longer selected. 

8.7    Arunas    2/13/03 
11:13:12 

AM  

Pending Install/ Upgrade Bug 14361 When installing, make path be 
F:pmwin\pm87 ('\' is missing after F:), 
where F: is my system disk > installation 
accepts this path and puts all the files to 
F:\WinNT\System32\pmwin\pm87. 

8.7.40.1    Arunas    2/21/03 
2:14:54 PM 

Pending Install/ Upgrade Update 14583 Update the installs and upgrade programs 
with files from PCR 14582 

8.7    TF    3/3/03 
10:03:11 

AM  

Pending Install/ Upgrade Update 14584 Update the install programs for GA 
release with the SP3 program file set (see 
14582) 

8.7    TF    3/3/03 
10:04:19 

AM  

Pending Install/ Upgrade Update 14585 Update the upgrade programs for GA 
release with the SP3 program file set 

8.7    TF    3/3/03 
10:05:06 

AM  

Pending Install/ Upgrade Update 14619 Remove pm.ag.pdf and pm.ug.pdf from 
the file set. If found on upgrade, remove 
them from the Help menu 

8.7.40.4    TF    3/4/03 
10:07:18 

AM  

Pending Matter DE Bug 14497 Receiving message "Exception occurred" 
every time I create a new document, in all 
matters 

8.7.40.1 Bacon & Wilson Mike G Feedback  2/26/03 
2:02:27 PM 
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Pending Matter DE Bug 14548 Receiving Message “Warning, YOUR 
connection to the database dropped” 
when Trying to assign entity in matter 

8.7.40.1 AmFam  Mike G Feedback  2/27/03 
4:32:43 PM 

Pending Matter DE Bug 14571 Receive Message “A component named 
frmEntityInfo already exists”when Entering 
Entity information in the Matter. Also, 
when Updating Entity address information. 
Comments: Wilkes also receives the 
same message: PCR 14550 

8.7.40.1 AmFam  Mike G Feedbak  2/28/03 
9:38:10 AM 

Pending Matter Listing Bug 14499 Trying to retrieve a filter which worked fine 
when it was created and applied, but 
every time we try to use the filter after that 
it gives the error below. We’ve tried 
clearing all filters before applying it and it 
still doesn’t work. 
Comments: Invalid floating point operation 

8.7.40.1 Glasser and 
Glasser  

Mike G Feedback  2/26/03 
2:13:53 PM 

Pending Matter Listing Bug 14542 Receiving Message “Warning, YOUR 
connection to the database dropped” 
when Going into preferences from Matter 
listings 

8.7.40.1 AmFam  Mike G Feedback  2/27/03 
3:46:03 PM 

Pending Matter Listing Bug 14575 Receive Message "Warning, YOUR 
connection to the database dropped" 
when Looking up claims numbers under 
"matter name" 

8.7.40.1 AmFam  Mike G Feedback  2/28/03 
10:36:28 

AM  

Pending Matter:Annotation
s 

Update 14560 Add auto-refresh to the Matter-Annotation 
listing to respect the System Setting 

8.7    TF    2/28/03 
10:01:47 

AM  

Pending Matter:Tree View Update 13776 Cannot view type from within timeslips 
when selected as a viewable column. 
Comments: Within a matter, go to 
treeview choose timeslips. From there 
choose options and select 'type' as a 
viewable column then hit ok. Type shows 

8.7.35.1 NFI Industries 
0262  

Ken 25144  1/23/03 
3:02:13 PM 
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up blank 

Pending Note DE Bug 13806 In Note DE have got an error 'Cannot 
focus a disabled or invisible window 
Select TexT'. 
Comments: This user has checked 
'Spellcheck Notes on Save' in User 
Preferences> General tab. Create new 
note enter required fields, enter any 
incorrect text for note (ex. 'hhome'), go to 
Related to Issues tab. Spelling screen 
appears, hit Ignore, then OK. In Related to 
Issues tab click on Close button. Have got 
confirm message 'Do you want to save 
the note?', click Yes. Have got an error. 

8.7.39.1    Rasa    1/24/03 
7:27:30 PM 

Pending Note DE Bug 14579 Receiving Message "Warning, YOUR 
connection to the database dropped" 
when Attempting to enter new Note 

8.7.40.1 AmFam  Mike G Feedback  2/28/03 
2:24:48 PM 

Pending Note Listing Update 14002 Add Other Party, Other Party’s Phone 
Number and Message text as available 
columns in the Notes Global listing 
Comments: per Feature Request from 
Wilkes & McHugh ("need to have ability to 
print phone notes") 
[PMT\tom 3/4/03] Also make sure they are 
available in the query. 

8.7.40.1 Wilkes & 
McHugh  

Cynthia K; 
Mike G 

   2/4/03 
9:01:04 AM 

Pending Note Settings Bug 14444 Receive “Warning, YOUR connection to 
the database dropped” message, when 
clicking on the administration menu – 
Notes 

8.7.40.1 AmFam  Mike G, Ken 
F 

Feedback  2/25/03 
3:19:39 PM 

Pending Printing Bug 14318 Clicking Cancel on the Print dialog box 
doesn't cancel printing. 
Comments: From any listings click Printer-
>on the Report Settings screen click Print 
Report-> on the Print dialog box click 

8.7.40.1    Mike G    2/19/03 
11:33:05 

AM  
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Cancel-> report still printed. 

Pending Printing Update 14469 Update the Save As functionality for list 
printing to by-pass QuickReports limitation 
on only saving what is in the preview -- all 
selected columns should be saved to the 
file 
Comments: [PMT\tom 3/4/03] I see two 
ways of handlings this: 
1. In Quick Reports, when you choose to 
save to file, include all fields from the 
Selected Fields panel on the Report 
Settings-Customize tab, regardless of 
what is actually displayed in the review. 
2. To the Report Settings - Main tab, add 
the ability to save to file using any of the 
file types in Quick Reports. Two mockup-
ups of this is attached - one for printing to 
the print and one for printing to a file. Click 
Print actually prints the report to file as the 
selected type. 
Either solution will be satisfactory. 

8.7    TF    2/26/03 
1:39:26 PM 

Pending Security Settings Update 14202 For firms upgrading from PM86 SP2 or 
earlier, automatically assign securities 
created in PM87 using the agreed upon 
auto-assign rules 
Comments: The following new securities 
should be automatically assigned to every 
existing role as they were applied to 
existing PM functionality that did not have 
security in earlier versions: 
-- Add New Entity Relationship 
-- All Filter/Query Access 
-- Allow clear Billable field on Entity 
Record 
-- Allow clear Client field on Entity Record 
-- Edit Entity Relationship 
-- Remove Entity Relationships 

8.7    TF    2/13/03 
9:14:26 AM 
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The following new securities should be 
automatically assigned to every existing 
role that has "Edit Standard Matter: 
General" as they were applied to existing 
PM functionality that originally inherited 
security from "Edit Standard Matter: 
General" in earlier versions: 
-- Edit Standard Matter: Billing 
-- Edit Standard Matter: Summary/Desc 
 
The following new securities should NOT 
be automatically assigned to any existing 
role because they represent new 
functionality in Practice Manager and 
should only be assigned based on the 
firm's internal policies: 
-- Allow General Bar Numbers 
-- Open Desktop View - Manager 
-- Open Desktop View - Single User 
-- Open Desktop View - Two-Party 
-- Outlook Access 
-- Report Errors and Send Feedback 
 
Note, for upgrade from PM87, we cannot 
auto-assign these functions because the 
firm has already been upgraded, 
assignments have been made, and any 
auto-assigning would over-write the firm's 
existing assignments 

Pending Security Settings Update 14609 The assignment of functional security 
options to a security role must include 
Date Created and Date Revised to 
support Web forms 

8.7    TF    3/4/03 
9:11:13 AM 

Pending Site Settings Update 13762 Modify the Drive Mapping DE form 
Comments: (1) modify the Drive Mapping 
DE form to strip out the last "\" and 

8.7    TF    1/23/03 
1:36:05 PM 
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(2) have the mapping logic also strip it out 
or ignore the last "\", if found 

Pending Site Settings Update 14352 GMT/UTC Preparation Requirements for 
SP1 - GMT/UTC Site Settings. 
Comments: On the Site D/E Form, add 
the following required fields: 
1. Timezone of the site - this list should be 
the same as that in Microsoft Window (I 
believe this can be read from the O/S). 
2. Automatically Adjust for Daylight 
Savings Time - Checkbox, which indicates 
whether or not the time at the site 
respects daylight savings time. 
[PMT\tom 2/21/03] The default value for 
this field should be the Time Zone of the 
SQL Server. The user can change as 
needed. 
 
Upon upgrade, make sure the Time Zone 
field is populated with the Time Zone of 
the SQL Server. 
[PMT\tom 2/21/03] On upgrade, the 
Automatically Adjust for Daylight Savings 
Time checkbox should be checked or not 
checked based on the settings for the 
SQL Server. 

8.7    TF    7/15/02 
3:33:13 PM 

Pending Source Code Bug 14586 Respect the Regional Options in timeslips 
and timeslip reports (same as PM80) 
Comments: I think this was something that 
was added in PM80 but never got added 
in PM81. I am classifying it as a bug 
because it is functionality that existed in a 
prior version that should have been 
carried forward, and was not... that makes 
it a bug 
[PMT\tom 3/3/03] Okay, we are going to 
handle this a bit differently in PM87 and 

8.7.40.4    TF    3/3/03 
11:00:45 

AM  
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higher. The plan is to allow the user to be 
able to select the format for the currency, 
similar to what you can do in Regional 
Settings. I think, for this release, we will 
simply add a Currency field under 
Date/Time Format that allows you to enter 
a symbol that will be used in all places in 
PM where a currency symbol appears. 

Pending Source Code Feature 14024 Add Publish Points to support Lotus Notes 
Integration 
Comments: [PMT\tom 3/4/03] A mini-spec 
will be avaiable by 03/07/2003. 

8.7    TF    2/6/03 
2:37:56 PM 

Pending System Settings Update 14351 GMT/UTC Preparation Requirements for 
SP1 - GMT/UTC System Settings. 
Comments: These values are for 
information only, and do not actually write 
values to the database. 
1. Add new field (read-only) to System 
Settings to display the timezone of the 
database server (this should be read from 
the system). 
2. Add a new field (read-only checkbox) to 
indicate whether the server time is 
automatically adjusted for daylight savings 
time. 

8.7    TF    7/15/02 
3:28:48 PM 

Pending TiffView Bug 14108 I just noticed that there is still logo and 
company name of law.com on the left side 
of %subj%. PM version is 8.7 SP2A. 
Comments: In both versions of Tiffviewer 
[PMT\tom 3/4/03] New bitmaps are 
available in 
\\Ltdevsql1\D\QA\builds\pm\pm_v87sp3\k
x\specs\pm.bitmaps\. Let me know if you 
need anything else for this. 

8.7.3.23    Audrius    2/10/03 
5:13:30 PM 

Pending TiffView Bug 14508 When close TiffViewer window, have got 8.7.32.5    Rasa    2/27/03 



Printed: 03/04/2003  Last Updated: 03/04/2003 
 RealLegal, LLC Confidential and Proprietary Information 
 Project Summary Specification � Practice Manager v8.7 SP3 

C:\Documents and Settings\TFOLEY\My Documents\rl.stuff\dev\pm_core\andes\pm87sp3\specs\pm87sp3_pss_v0100.doc  
Copyright © 1992-2003 RealLegal, LLC, Rev. No. 22 Scope – Inclusions l 27 

Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

an error. 
Comments: Open document with 
TiffViewer (this document has 11 pages). 
In Page menu> Visible Pages is set 20 
pages. With Next Page button go to the 
last page. Then from Page> Visible Pages 
set 5 pages, OK. Close Tiff Viewer. Have 
got ant error 'List index out of bounds (0)' 

12:45:59 
PM  

Pending TiffView Bug 14639 In Window menu displayed not all of 
document's pages and order of pages is 
incorrect. 
Comments: Open multipage image with 
Tiff Viewer (for example there are 11 
pages). Go to Window menu, you see just 
4 pages. Clicking arrow button go to next 
pages. Again go to Window menu, now 
you see more pages.  
Also the pages are not ordered (the firs 
displayed 'page #4', 'page #3', 'page #2', 
'page #1', 'page #5', ….) 

8.7.0.24    Rasa    1/27/03 
1:36:35 PM 

Pending Timeslip DE Bug 14452 Receive “Warning, YOUR connection to 
the database dropped” message, when 
creating timeslip 

8.7.40.1 AmFam  Mike G; Ken 
F 

Feedback  2/25/03 
4:21:18 PM 

Pending Timeslip Listing Bug 14013 Got an access violation error after 
archiving the timeslips. 
Comments: Timeslip Settings -> General -
> Billing Program: Juris -> check Enable 
Advanced Timeslip Archiving -> Save. 
Open Timeslip Listing, go again to 
Timeslip Settings and choose PMBill, 
press Save. Right-click in Timeslip Listing 
-> Archive -> List -> Get an error 'Invalid 
column name 'ACTIONDATE' ' -> OK. 
Right-click again, choose View Archive -> 
again the same error appears -> Buttons 
'New' and 'Open' disapear -> press OK. 

8.7.40.1    Sigita    2/4/03 
3:39:40 PM 
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Right-click once more, choose View 
Archive -> again the same error appears -
> Buttons 'New' and 'Open' apear -> press 
OK. Press 'Open' -> Timeslip Template 
DE is opened and you get an error 'Query 
TimeslipListing: Field 'TIMESLIPID' not 
found' -> OK. Press Close -> get an 
access violation error 'Access violation at 
address 0087B17E in module 
'PMWIN.exe'. Read of address 00000008. 
(When PMBill is chosen, one has to rerun 
Timeslip Listing, as archiving is not 
allowed with PMBill. I simply forgot to 
rerun Timeslip Listing, the timeslips were 
archived, but the above behavior 
occurred. I had to restart PMWIN, go 
again to Juris in order to get all the 
timeslips back from archive.) 
[Vygintas] I would consider this a low 
priority bug, because of unlikely scenario - 
changing billing program on the run. Also 
this change to PMBill is 'illegal' as 
required script is not run, which triggers 
"Invalid column name 'ACTIONDATE". 
But anyway this problem is complex. 
1. Access Violation could be prevented by  
a) improving Timeslip Listing - do not 
open Timeslip DE by pressing 'Open' 
when listing is empty. 
b) improving Timeslip DE - do not free 
objects on destroy that were not created  
c) both 
2. How to prevent archiving when PMBill 
is selected 
a) Read "Disable Archiving" setting right 
before archiving. Stop if not allowed 
b) make changes to any Timeslip General 
settings to be effective only after PM 
reload.  
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c) both 
3. Prevent change to PMBill when script is 
not run. 
- not sure how 
I suggest 1. c) and 2. a) for Corazon 

Pending Utility Bug 14429 PMTemplate convert utility problem with 
Corel8. 
Comments: e.g. in a component exist 
following format: 
IFNOTBLANK(Mat_CivilActNo)Case No. 
FIELD(Mat_CivilActNo)ENDIF. When run 
utility, changed just one field - 
IFNOTBLANK(Mat_CivilActNo)Case No. 
FIELD(Mat_CaseNo)ENDIF. Should be 
IFNOTBLANK(Mat_CaseNo)Case No. 
FIELD(Mat_CaseNo)ENDIF.  
Looks like, that changed just field which 
has format FIELD(Mat_CivilActNo). 

1.1.2.7 Bowers Harrison Rasa 23879  2/25/03 
2:42:01 PM 

Pending Workflow DE Bug 13798 PMWin Not responding when negative 
number is selected in Workflow Activities 
Schedule. 
Comments: Open Workflow DE and click 
on Occurrence button. In Schedule 
Activity window select Weekly frequency. 
There is possibility to choose negative 
number in activity occurrence every … 
week field with buttons. Set activity 
occurrence every -4 (any negative 
number) week. Hit Save. PMWin Not 
responding. 
[PMT\tom 3/4/03] Do not allow negative 
numbers in frequency fields. 

8.7.39.1    Ligita    1/24/03 
4:10:26 PM 

Pending Workflow DE Bug 13813 In Appointment DE press on cowboy hat 
near Location field. Select one of entities 
from Entity Listing which is not Staff. 
Answer yes to assign as participant to 

8.7.39.1    Ligita    1/24/03 
8:38:43 PM 
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activity. Add Entity DE Entity name faucet 
filter and OK button are disabled. 

Pending Workflow DE Bug 14250 Access violation, when entering a task 
into PM 
Comments: Access violation at address 
01BD980A. Write of address 00000050 

8.7.40.1 Wilkes & 
McHugh  

PSTANLEY Feedback  2/17/03 
3:31:48 PM 

Pending Workflow DE Feature 14647 Add the ability to suppress the Status 
Change dialog box. This is both a System 
Setting and User Preference 
Comments: 1. Add a System Setting 
(Saulius -- You may wan to create a 
"Workflow" tab in System Settings and 
move all the workflow-related items to it... 
the General tab is getting really full -- In 
Chimborazo, all this moves to a General 
tab in Workflow Settings): 
Show Status Change dialog when items 
are 
[_] Marked "Cancelled" 
[_] Marked "Not Started" 
[_] Marked "In Progress" 
[_] Marked "Completed" 
 
2. If the System Setting in #1 is NOT 
checked, then new Edit - Preferences 
appear on the Workflow tab: 
Show Status Change dialog when items 
are 
[_] Marked "Cancelled" 
[_] Marked "Not Started" 
[_] Marked "In Progress" 
[_] Marked "Completed" 
 
The options in #1 allow the firm to set a 
policy about whether this form is required 
or not when the status is ... some firms 
want it, which is why it was added. 

8.7  TF  3/4/03 
6:01:11 PM 
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The options in #2 allow the user to 
suppress the automatic display of this 
form when the status of an item is 
changed IF the firm allows the form to be 
suppressed for the status (based on 
selections in option in #1). 
 
For example, if the firm checks "Not 
Started" and "Cancelled" in #1, the user 
CANNOT suppress the form when 
choosing either of those statuses; 
however, if the user chooses to, they can 
suppress the form so it does not appear 
when changing the status to "In Progress" 
or "Completed". 
 
When we implement this, only "Cancelled" 
would be checked in #1 and nothing 
would be checked in #2 by default, as that 
basically replicates the same functionality 
as PM80 for marking an item Complete 

Pending Workflow Listing Bug 14388 If you remove Matter No column from the 
listing and save Grid layout, after closing 
and reopening PM column still displayed. 
Comments: Only Workflow Global listing 

8.7.40.3    Mike G    2/21/03 
12:34:53 

PM  

Pending Workflow Listing Update 13742 Multiselect>change status not always 
working 
Comments: From WF test plan In 
Workflow Listing select multiple rows, 
change Status usin View>Change Status  
when I select 4 items to change, usually 
only 3 have their status changed. It seems 
that the right click actually deselects a 
record 

8.7.38.1    Ken    1/22/03 
11:26:52 

AM  

Done Database Info 14154 NT Authentication configuration steps. 8.7    Ken    8/6/02  
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Comments: Here are steps to set up the 
environment in order to test NT 
authentication. 
Practice Manager currently does not 
create Windows users when creating 
Entities when "NT Authentication" option 
is selected in System Settings. 
Therefore for every user entity created in 
Practice Manager you will have to perform 
these steps. 
 
Scenario if "NT Authentication" setting is 
enabled in PMWIN. 
1. Create NT user using NT user creation 
tools as administrator of machine or 
domain. 
2. Create Entity of type USER in Practice 
Manager. Login for this entity must be the 
same as the NT username, such as 
[MY_USER]. This is because Practice 
Manager in addition to existing system 
security (SQL type or NT Authentication) 
verifies if such user has rights to access 
Practice Manager database. 
3. Start Enterprise Manager. 
4. Go to <Server_Name> -> Security -> 
Logins. 
5. Create new login and enter login for the 
machine or domain, such as: 
MY_DOMAIN\MY_USER, where 
[MY_DOMAIN] is NT domain name or 
your machine name, and [MY_USER] is 
NT domain or machine user. 
5.1. Go to Database Access tab and 
select databases this login will be able to 
login to. This action will create appropriate 
user in those databases, such as 
[MY_USER]. 
5.2. Select roles that are permitted for that 
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user in every database you've selected. 
Roles list is: 
5.2.1. Public 
5.2.2. DB_SECURITYADMIN - Can 
manage all permissions, object 
ownerships, roles and role memberships. 
5.2.3. DB_DDLADMIN - Can issue ALL 
DDL, but cannot issue GRANT, REVOKE, 
or DENY statements. 
5.2.4. PM - this is Practice Manager role 
which specifies access to all Practice 
Manager data objects. 
6. Make sure your machine is part of the 
domain, if you need to access remote DB 
as a domain user using NT authentication. 
6.1. To verify that, right click on icon My 
Computer on your desktop. 
6.2. Go to Properties -> Network 
Identification tab -> Properties and select 
"Member of Domain" and pick required 
domain, such as MY_DOMAIN. 
6.3. This action will require domain 
administrator login and password to 
confirm that such machine can be part of 
specified domain. 
6.4. Reboot your machine and login as 
domain user into Windows OS. 
7. Check you UDL file, so that it has 
correct settings. 
7.1. Pick right server in UDL configuration. 
7.2. Select "User Windows NT integrated 
security 
7.3. Select required database. 
8. Start Practice Manager with switch 
PMWIN.EXE /UDL=MY_UDL.UDL 
9. If you want to access local server 
(running on your machine), make sure 
that you are logging into your machine 
when logging into Windows NT. 
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Done Document 
Assembly 

Bug 14277 When you merge a document with more 
than one role and include the bar number 
field, only the bar number for the first 
entity with the first role is being pulled in 
Comments: Steps to recreate: 
1. Create a template with two different role 
field groups, each group containing Bar 
Number. For example: 
Entity Role / Attorney -- Co-Counsel: { 
Field("ER149AttorneyCocounsel_NS") } { 
Field("ER149AttorneyCocounsel_BarNum
ber") } 
Entity Role / Assessor : { 
Field("ER101Assessor_NS") } { 
Field("ER101Assessor_BarNumber") } 
2. To a matter, assigned one entity with 
one role (e.g., Attorney -- Co-Counsel) 
and another entity with the other role (e.g., 
Assessor). Be sure that each entity has at 
least one bar number. 
3. Merge the documents. Note that the 
Bar Number is the same for both Entity 
Role fields, and appears to use the value 
from the first entity assigned to the matter 
with one of the roles. This is wrong. The 
value that is pulled should be the first 
entity of that role, and the process 
repeated for each role, just like Date of 
Birth.  
I also noticed that, when you are merging, 
it doesn't ask you to select a bar number 
for each role, even though the entity from 
which the bar number is pulled has 
multiple bar numbers. The sequence 
should be as follows: 
1. Merge the document. 
2. From the first entity assigned with each 
role associated with the bar number field, 
select the bar number from that entity. 

8.7.40.1 AmFam  TF    2/18/03 
11:39:33 

AM  
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2.1. If the entity has more than one bar 
number, display a pick screen for that 
entity role. 
3. Repeat for each role 

Done Document 
Assembly 

Bug 14279 When you merge a document with more 
than one type field group and include the 
bar number field, only the bar number for 
the first entity with the first type is being 
pulled in 
Comments: Steps to recreate: 
1. Create a template with two different role 
field groups, each group containing Bar 
Number. For example: 
Entity Role / Attorney -- Co-Counsel: { 
Field("ET1002Adjuster_NS") } { 
Field("ET1002Adjuster_BarNumber") } 
Entity Role / Assessor : { 
Field("ET1004CourtReporter_NS") } { 
Field("ET1004CourtReporter_BarNumber"
) } 
2. To a matter, assigned one entity of one 
type (e.g., Adjuster) and another entity of 
the other role (e.g., Court Reporter). Be 
sure that each entity has at least one bar 
number. 
3. Merge the documents. Note that the 
Bar Number is the same for both Entity 
Type fields, and appears to use the value 
from the first entity assigned to the matter 
of one of the types (a pick screen appears 
for the Entity Type group if the entity has 
more than one bar number). This is 
wrong. The value that is pulled should be 
the first entity of that role, and the process 
repeated for each type, just like Date of 
Birth. 
I also noticed that, when you are merging, 
it asks you to select a bar number for the 

8.7.40.1 AmFam  TF    2/18/03 
11:42:33 

AM  
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Entity Type group instead of a specific 
entity type. The sequence should be as 
follows: 
1. Merge the document. 
2. From the first entity assigned of the 
type associated with the bar number field, 
select the bar number from that entity. 
2.1. If the entity has more than one bar 
number, display a pick screen for that 
entity type. 
3. Repeat for each entity type. 

Done Document 
Assembly 

Info 14343 When making a copy of a document the 
Document Profile screen will sometime 
have buttons grayed out. 
Comments: It seems like if you change 
matter’s law type and this law type doesn’t 
have same Document Category-
>Document Type assignment, as previous 
law type, buttons will be grayed out 
(document opens fine and when click 
Profile, buttons are not grayed out) 
 
When you do not change matter’s law 
type, but simply unassigned Document 
Type from this Law type and Document 
Category, buttons are not grayed out, but 
Type field is empty (I think this is not what 
we say on client’s db, but this is what I get 
on my local db). This is probably correct 
behavior. 

8.7.40.1 Bacon & Wilson Mike G 25997  2/20/03 
5:08:59 PM 

Done Document 
Assembly 

Update 14465 Update the document profile so that the 
"Assemble with..." fields on the Profile 
default to the same component type as 
that of the default template 
Comments: This allows the HotDocs 
template to appear when it is set as the 
default. Right now, you have to actually 

8.7    TF    2/26/03 
1:18:29 PM 
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click on "Assemble with HotDocs" in order 
to see the default template. 
-- If the default template for the 
assignment is a Practice Manager 
template, "Assemble Document with 
Practice Manager" would be selected. 
-- If the default template for the 
assignment is a HotDocs template, 
"Assemble with HotDocs" would be 
selected. 
-- If there is no default template assigned, 
"Assemble Document with Practice 
Manager" would be selected 

Done Document 
Assembly Merge 

Bug 14091 The problem with HotDocs. 
Comments: When create new document, 
select index (this index length is longer 
than 8 symbols) and merge with HotDocs 
template components, document is not 
merged. HotDocs Pro screen is invoked 
and merge process stopped. 

8.7.40.1    Rasa    2/10/03 
5:18:50 PM 

Done Document 
Assembly Merge 

Bug 14232 Problem when try to copy HotDocs 
component. 
Comments: From Document Assembly 
Settings create e.g. HD template. Then try 
to copy this template. In Document 
Component Design screen click on 
Design button. Have got an error (see 
attachment). Click OK. After that template 
is created. 

8.7.40.1    Rasa    2/14/03 
11:25:03 

AM  

Done Document 
Assembly Merge 

Bug 14248 The problems with HotDocs. 
Comments: 1) When create new 
document, select index (this index has 
folder with space symbol, example 
C:\Practice Manager) and merge with 
HotDocs form component, document is 
not merged. With HD template component 

8.7    Rasa    2/17/03 
2:52:13 PM 
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document is merged. 
2) When PMWin root path is e.g. 
C:\Program Files\RealLegal\PRACTICE 
MANAGER\Practice Manager 87401\, 
then you cannot create new HD template 
of Form components. 

Done Document 
Assembly Merge 

Bug 14346 When you merge a document with more 
than one role and include the note fields, 
only the note for the first entity with the 
first role is being pulled in. 
Comments: 1. Create a template with two 
different role field groups, each group 
containing Note Description, Note Text 
fields. 
2. To a matter, assigned one entity with 
one role and another entity with the other 
role. Each entity has at least one note. 
3. Merge the documents. The Note 
Description and Text is the same for both 
Entity Role fields. 

8.7.40.3    Rasa    2/21/03 
10:06:22 

AM  

Done Document 
Assembly Merge 

Bug 14348 When you merge a document with more 
than one type and include the note fields, 
only the note for the first entity with the 
first type is being pulled in. 
Comments: 1. Create a template with two 
different type field groups, each group 
containing Note Description, Note Text 
fields. 
2. To a matter, assigned one entity with 
one type and another entity with the other 
type. Each entity has at least one note. 
3. Merge the documents. The Note 
Description and Text is the same for both 
Entity Type fields. 

8.7.40.3    Rasa    2/21/03 
10:06:22 

AM  

Done Document DE Bug 14120 Go to PMWIN document listing > select a 
document and click Copy > document 

1.2.6.0    Arunas    1/30/03 
11:34:41 
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profile window opens. Fill all the fields with 
the data related to DOCS Open 
integration > select Version Control 
checkbox > click Open Document. 
Comments: The system presents a 
question: "This document has Version 
Control. Do you want to open a New 
Version of the document?". Click Yes > 
create new version of the document. This 
just created document will not appear in 
DOCS Open. 
If I answer No to the previous question, 
then this newly created document will 
appear in DOCS Open. 

AM  

Done Document DE Info 13724 Message "Cannot Open File" is displayed 
when Document Profile is opened 
Comments: The application I am using is 
Windows Imaging. Comes with Windows 
2000. After the conversion, those records 
do not open. I did not change anything in 
the application settings. The file format of 
the record I am trying to open is Jpg 

8.7.38.1    Abe 139-764  1/22/03 
6:36:45 PM 

Done Documentation/M
anuals/Help 

Update 14481 Update readme.txt with info regarding 
<PMROOT>\KOFAX_INS directory - see 
14410 

8.7.40.4    Donatas    2/26/03 
3:44:42 PM 

Done Documentation/M
anuals/Help 

Update 14582 Create install and upgrade files for SP3, 
as well as update the release notes 

8.7    TF    3/3/03 
10:01:21 

AM  

Done Install/ Upgrade Update 14410 Include the new TiffView AIPE in the client 
install 

8.7    TF    2/24/03 
6:26:21 PM 

Done Install/ Upgrade Update 14434 Include 
WFItemsCancelingInClosedMatters.exe 
utility into installs/ upgrades for 8.7.40.4 

8.7    TF    2/25/03 
5:00:25 PM 
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Done Matter:Workflow Feature 14396 Create utility that would complete all plans 
and mark unscheduled and uncompleted 
items as cancelled for matters that are 
closed 
Comments: Let's add this to the SP2A 
utility folder as a self-extracting EXE, with 
the script inside it. 
The scope of the script should be as 
follows: 
1. Unscheduled Workflow Items in Closed 
Matters should be marked as Cancelled. 
2. Uncompleted (not started or in 
progress) Scheduled Workflow Items in 
Closed Matters should be marked as 
Cancelled. 
3. Plans in closed matters should be 
marked as complete. 
4. Completed plans in closed matters 
should be scheduled for purging. 

8.7    Ricky    2/24/03 
2:41:40 PM 

Done TiffView Update 14358 Update TiffView to save settings (similar 
to 13544) 
Comments: The Tiff viewer has the same 
problems that the image viewer had:  
A) it always opens in windowed mode, not 
full screen  
B) you need to manually expand the 
application  
C) then you need to manually expand the 
document (on every page!)  
D) then you need to tell it "Fit by width"  
E) and it does not "remember" these 
settings, so you have to do it all over 
again for every document you open 

8.7 Amfam  TF    1/17/03 
5:07:15 PM 

Done Timeslip Listing Update 13778 User opens timeslip tab from within a 
matter. Recieves error message 'Either 
BOF or EOF is true or the current record 
has been deleted. Requested operation 

8.7.35.1 NFI Industries 
0262  

ken 25142  1/23/03 
3:11:26 PM 
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requires a current record.' 
Comments: steps to recreate: 
Client opens a matter, goes to the timeslip 
listing for a given matter (ccbss). Upon 
opening the tab, they get the error 
message 'Either BOF or EOF is true or 
the current record has been deleted. 
Requested operation requires a current 
record.' 
 
From there, click on filters, choose no 
filter. Then go back and choose 'all' from 
'in last days'. Timeslips can now be 
opened. Again though, if you tab out and 
then tab back in, you get the exact same 
message. 
Is the result consistent or randomly 
occurring? 
Consistent for the matter given. Random 
for others 

Done Utility Update 14433 Update the start.htm and start.js pages in 
\\Ltdevsql1\D\QA\builds\pm\pm_v87sp2\b
uild874004\files\utilities\ for the 
WFItemsCancelingInClosedMatters.exe 
utility 

8.7    TF    2/25/03 
4:59:19 PM 

Done Workflow Listing Info 13564 Go to workflow listing > click Printer icon > 
go to Customize tab. Preview button is 
active. Click [>>] button (assign all 
available fields) > Preview button 
becomes inactive. I need to restart 
Printing to make this button be active. 
Comments: [PMT\tom 1/19/03] Yes, was 
agreed that any customization for printing 
on any listing where a BLOB field is added 
-- in this case, Instructions and Notes -- 
the Preview button becomes disabled. If 
the user removes the BLOB fields as 

8.7.38.1    Arunas    1/18/03 
1:33:08 PM 
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Selected Fields, then the Preview button 
is enabled. 

Final Desktop Views Info 13727 On Next week and Next two weeks time 
frame under a heading called “Current” 
appear tasks which have the Due Date 
from current (i.e. although time is set to 
next week, today's, tomorrow's and etc. 
tasks appear under “Current”). 
Comments: Under heading called 
“Current” shouldn't tasks which have the 
Due Date corresponding with selected 
time frame appear? 
In the FDS there is such paragraph: 'On 
the Today, This Week and Two Week 
Views, tasks where the Due Date has not 
yet occurred, based upon Today’s date, 
should be grouped under a heading called 
“Current”. Those tasks where the Due 
Date is before Today’s date should be 
grouped under a heading called “Past 
Due”.' 

8.7.38.1    Ligita    1/22/03 
6:19:55 PM 

Final Document 
Assembly 

Info 14577 Receive Message "Word cannot open this 
document template" when trying to open 
fax template in forms. 
Comments: Also, when Trying to generate 
a blank letter with letterhead. Also, Trying 
to open up the letter to Clerk letter number 
400-A document that had already been 
generated. I was adding on to the 
document. Also, when preparing profile to 
create a letter. Also, when preparing 
profile to create a letter. Also, trying to 
generate an BLANK document since the 
computer wouldn't let me generate a FAX 
cover sheet. Also, when Creating letters 
and memos; changing suspense dates 

8.7.40.1 AmFam  Mike G Feedback  2/28/03 
10:44:32 

AM  
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Final Document Listing Info 14342 WordPerfect docs are no longer opening 
using word XP, but only if you try to open 
them from the listing. 
Comments: In document listing, find a 
document that was originally created in 
WP (office now uses word XP) and click 
on the open button on the command bar. 
Error message says that document cannot 
be found. Take that same document, open 
the profile and then click open document. 
Document opens fine. 
[Mike G] It appears that all these 
documents have path f:\ (lower case), if 
you look in Documents Global listing. But 
if you open a profile, path has F:\ (upper 
case). 

8.7.40.1 Fuller, Johnson 
& Farrel  

Mike G 25995,Feedb
ack  

2/20/03 
5:01:57 PM 

 

7. Scope – Exclusions 

This report is taken from the PCR Database.  It is all PCRs in SP3 that, as of March 04, had a status of Under Review, Not Applicable or 
Deferred.  This list is subject to update, and the PCR Database always represents the latest and greatest version of this report. 

The report is first sorted by Status, then Area, then Type and finally by ID. 

There are additional fields available when this report is accessed from the PCR Database.  Note that the links currently point to Thunder.  This 
is only available if you connect to the PCR Database from the Lithuanian office or from the VPN.  At the time this report was generated, there 
as no quick way to correct this.  Future updates should have this corrected. 

 

Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

Under 
Review 

Entity DE Bug 13810 New DE forms created from Entity 
Related Tree view are opened behind the 
Entity DE window. 
Comments: Go to Entity DE Related Tree 
tab. Add new Entity relationship. In 
Relationship Properties window press on 
cowboy hat near Entity 2 Name field. 

8.7.39.1    Ligita    1/24/03 
8:17:07 PM 
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Create new entity record from opened 
Entity Listing window. Go to Related Tree 
tab of just created entity. Add new 
document - new Profile DE is opened 
behind the Entity DE window and is not 
accessable. Same problem when adding 
new Timeslips and Notes. 
[PMT\tom 3/4/03] First, we need a time 
estimate for what it will take to fix this. Do 
not proceed with the work until the time 
estimate has been approved by me. 

N/A Install/ Upgrade Bug 14073 Review PM uninstall/install. Seems like it 
doesn't remove/update all files. 
Comments: I noticed a problem with 
PMConduit.dll during PM uninstall/install. 
When I uninstalled PM from my local 
machine, PMConduit.dll was not removed. 
When I installed build 8.7.40.1, 
PMConduit.dll was not updated (I have 
version 1.0.1.12 before and after 
installation.) 

8.7.40.1    Mike G    2/7/03 
5:11:42 PM 

N/A System Settings Update 13472 Add new Preference: Open Document O 
Maximized O Normal 
Comments: Document - Merge Document 
and Open Document should respect this 
setting 

     TF    1/16/03 
6:52:54 PM 

On Hold Matter Listing Bug 14528 Not all matter-related items, mentioned in 
the message, appering after choosing 
some matter for deletion, are deleted. 
Comments: When I choose to delete a 
matter, a message is displayed: 'Are you 
sure you want to delete the selected 
matter record(s) and all matter-specific 
items, including notes, documents, 
timeslips, groupware and workflow items?' 
If you choose 'Yes', everything is deleted 

8.7.40.4    Sigita    2/27/03 
3:58:28 PM 
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except notes and workflow. I think, these 
two should then be removed from the info 
message. 

On Hold Workflow DE Bug 13765 There is no way to get out of plan. 
Comments: PM 8.7.38.1 
SQL Server: SRV1 
DB Wilkes38 
Add plan 'Trial'; set 'Trial' task date on 
current date; will be created 4 repeating 
items. Parent 'Trial' task has 12 linked 
actions. The Due Date of task 
'Prepare/update bills, liens, med records, 
wage info, etc.' is set on 90 days before 
'Trial' is due. Open 'Trial' task DE; go to 
Automatic scheduling tab and set 'Trial' 
task due date on 'Prepare/update bills, 
liens, med records, wage info, etc.' task is 
due. Hit save, answer YES on messages 
about date change of linked activities and 
OK about repeating activities. 'Weekend 
Date' window appears. It doesn't matter 
how many times you click OK button, the 
'Weekend Date' window appears 
proposing to move activity's due date. 
Date in Scheduled date field goes 
backward. By clicking OK button on these 
windows, starting from year 2002 I got to 
year 1820 and they still appear. I had to 
kill PMWin. 

8.7.38.1    Ligita    1/23/03 
2:47:21 PM 

Deferred Components Feature 14199 Use “No.” consistently throughout PM 
(right now we have “#” and “Number”). 
Comments: The places below should be 
updated: 
Entity global – Timekeeper Number 
Document global – Version # 
Timeslips global – Matter #, Timekeeper 
Number 

8.7.40.1    Mike G    2/12/03 
4:22:18 PM 
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Matter global Filter – labels: Matter #, 
Case #, Closed # 
Entity global Filter – label: All Phone #s 
Entity global query – Timekeeper Number 
Document global query – Version # 
Timeslips global query – Matter #, 
Timekeeper Number 
Groupware global query – 
CLIENTNUMBER, MATTERNUMBER 
Document Profile: Document Versions 
screen – Version number 
Note DE: Relate to Matters tab – Number 
(should be Client Matter No.) 
Note: Phone Call DE: Relate to Matters 
tab - Number (should be Client Matter 
No.) 

Deferred Components Bug 14413 When trying to resize Select Visible 
Columns screen, it changes screen size 
but doesn't actually resize Avaliable Fields 
and Selected Fields. 
Comments: Right click on any listing and 
choose More Columns-> resize Select 
Visible Columns screen 

8.7.40.3    Mike G; Ken 
F 

   2/24/03 
1:59:01 PM 

Deferred Components Update 13748 With WinXP, there is a problem with 
minimize, restore windows. 
Comments: Mike and I have both 
experienced this. We just work in pm for a 
while, then at some point PM will not 
minimize. There is a single instance of PM 
running. 

8.7.38.1 Patten  Ken    1/22/03 
3:42:45 PM 

Deferred Desktop Views Bug 13669 Spelling error: message reads "Please go 
to Edit – Preferences – Views, and 
selected". Should be “select” 
Comments: Message : Error - Unable to 
Open desktop View. 

8.7.38.1    Mike 
Girenko 

   1/20/03 
4:00:37 PM 
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Deferred Document 
Assembly 

Bug 12376 DB=Glasser87.Engine=Word97. Merge 
new document with doc asm component. 
All field are merged. Leave generated file 
opened. Create another document and 
use the same doc asm component. 
Merge. There are some fields not merged 
in this document 
Comments: [TAF 01/23/2003] There is not 
enough time in SP2 to get this coded and 
properly tested. It is potentially a high-risk 
fix, and a behavior that can be observed 
in Word when used outside of PM. Please 
note that part of the reason we did not 
have time to address this PCR in SP2 is 
because other PCRs, namely those 
involving AMFAM and Saga, were 
received late in the development cycle 
and superceded this one with respect to 
resource allocation. Also, this one was not 
reported by the field and it only seems to 
happen with Word97 on some OSs. If 
needed, we can look at this at a later date 
and update independently, as we believe 
the problem is in the WLL (similar to 
issues we were having in PMDAT.DLL 
early on). 
 
(these fields are displayed as code (ex. 
{Field("Mat_LongName")} )). 
 
Exactly steps to recreate: 
Tested on QA-NT. DB=Glasser872. 
Engine=Word97.  
1. Login to PM (Name = Rasa, password 
= r) 
2. Hit New Document. 
3. Select Outgoing document type. 
4. View> Retrieve, select '_RM-W97' 
document template. 

8.7.33.1    Rasa    11/15/02  
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5. Hit Generate Document. 
6. Word document is merged. All fields 
retrieved. 
7. Leave this document opened and hit 
New Document button again. 
8. From View> Retrieve, select '_RM-W97' 
document template. 
9. Hit Generate Document. 
10. Not all fields are retrieved. 

Deferred Document 
Assembly Settings 

Bug 14148 Document Component Design screen: 
with Win XP theme and 800x600 
resolution, Aux label gets cut off (see 
screenshots) 

8.7.40.1    Mike G    2/11/03 
4:26:28 PM 

Deferred Document 
Assembly Settings 

Bug 14150 Document Assembly Settings:Assignment 
tab – with Win XP theme and 800x600 
resolution “No Assignments (DocTypes 
Only)" label gets cut off 

8.7.40.1    Mike G    2/11/03 
4:40:04 PM 

Deferred Document 
Assembly Settings 

Bug 14152 Date Formatter screen (Document 
Assembly Settings: Option tab)-spelling 
error "Description and EXMPLE". Should 
be "Example" 

8.7.40.1    Mike G    2/11/03 
4:50:53 PM 

Deferred Document DE Bug 13783 1) Open Document Versions screen 
(Profile DE> List Versions button) . When 
file does not exist, maybe Open 
Document button should be disabled like 
in Profile DE? 
Comments: 2) Also when open Document 
Versions screen of a document which 
SiteID is not the same as Active SiteID 
and Site Security is on, Edit, Delete 
buttons are enabled. When click on any, 
nothing happens. Maybe should be better, 
that these buttons should be disabled? 

8.7.38.1    Rasa    1/24/03 
9:13:21 AM 

Deferred Document DE Bug 13794 Problem when create document and 
select Profile Only template. 

8.7.38.1    Rasa    1/24/03 
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Comments: For example: Create new 
document (not Profile Only), from View 
menu> Retrieve Template select Profile 
Only template. After that in Location field 
displayed just '\' symbol. If I select other 
Index, the Location is not changed. I can 
select Document Assembly Template and 
try to generate document, have got MS 
Word error. 

3:38:00 PM 

Deferred Document DE Feature 14566 Add Check out/in functionality to 
documents. 
Comments: This is actually Document 
Management area 
Email from Jim Stewart 3/11/2002 

8.7.35    TF    12/10/02  

Deferred Document DE Update 14096 Entities Tab in document profile and 
assignments. See comments 
Comments: in 8.6.35.4 assignments under 
the entities tab in a document profile had 
to be made manually. There were no 
default assignments. In 8.7.40.1 it seems 
that Author/Creator are automatically 
assigned. Also - Every user that enters 
the entities Tab will be assigned. Is the 
last part linked to desktop views perhaps? 

8.7    Ken 25741  2/10/03 
1:40:03 PM 

Deferred Document Listing Bug 13640 When open word document from 
Document listing, on Task Bar see that 
the first 'Document1' is opened, it 
disappear and after PM document 
opened. 

8.7    Rasa    1/19/03 
2:58:00 PM 

Deferred Document Listing Bug 13788 The messages when file is not founded: 
Comments: 1) Site Security is on. When 
open Profile which SiteID is not the same 
as Active SiteID and file of this document 
does not exist, have got just a message 
‘Cannot edit record, because it does not 

8.7.38.1    Rasa    1/24/03 
10:24:48 

AM  
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belong to your Site’ and some fields, 
buttons are disabled. I think that also 
should be displayed a message ‘… file is 
not found…’ 
2) Site Security is off. When open Profile 
which file does not exist, no message is 
displayed (I think should be a message 
‘…file is not found…’). When click on e.g. 
List Versions, or click on Save button, the 
first have got message ‘…file is not 
found…’ and then listing is opened. 
Should be no message displayed. (Like 
works when Site Security is on). 
3) Site Security is off. In Document Listing 
select a document which is on other drive 
and drive mapping does not exist. Click on 
Open button; have got ‘Directory does not 
exist…’ Then click on Copy button, have 
got ‘…file is not found…’ I think, that will 
be better if the messages will be the 
same. 

Deferred Documentation/M
anuals/Help 

Update 13997 Update PMRemote manual 8.7    Aurelija    2/4/03 
10:56:08 

AM  

Deferred Entity DE Bug 13668 When open Issue DE from Entity Related 
Tree, "Specific to this matter" checkbox 
should be disabled or invisible 

8.7    Donatas    1/20/03 
7:02:08 PM 

Deferred Entity DE Bug 13812 When clicked Copy on Assign/Copy 
Parent Address screen the same address 
copied twice to the child entity 
Comments: Create organization entity and 
choose Parent Organization, on the 
Assign/Copy Parent Address click Copy 
one time and close it -go to Address tab - 
address copied twice. 

8.7.39.1    Mike G    1/24/03 
11:39:38 

AM  
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Deferred Entity DE Bug 13819 Hourly Billing Rate screen-OK and Cancel 
buttons get cut off, when Display 
Properties:Theme set to WinXP (800x600 
resolution) 
Comments: Entity DE:Rates tab -> click 
New 

8.7.39.1    Mike G    1/24/03 
5:39:22 PM 

Deferred Entity Listing Bug 14214 Go to Global Matter listing, make first 
column in focus > type-search anything > 
click Escape button and go to Global 
Entity listing until Matter Listing is not 
refreshed > make first column in focus > 
type-search anything. 
Comments: Actually now focus remain in 
Global Matter listing, but you do not see it. 
And you do not see what you type-search, 
because it all appears in Global Matter 
listing. 
I suppose the same happens with all 
listings. 
This is easy to recreate on big databases. 

8.7    Arunas    2/13/03 
1:15:11 PM 

Deferred Entity Settings Bug 14054 Go to Address Description tab > click New 
> enter new address description and click 
Enter > system asks if I really want to 
cancel. Usually clicking Enter is accepted 
as clicking OK, not Cancel. 

8.7    Arunas    2/7/03 
2:28:01 PM 

Deferred Entity Settings Bug 14438 Role Assignment Filter – “Side” 
checkboxes do not respect Law Type or 
Role settings 
Comments: Entity Settings: Assign Role 
or Assign to role tabs-click Listing button- 
on the role Assignment Listing screen 
click Filter button- Role Assignment Filter 
screen: if you filter by Law Type or Role, it 
works fine; but if you filter by Law Type 
and check any checkboxes (N, P, or C), 
results will be filtered by Side only, not by 

8.7.40.3    Mike G    2/25/03 
11:53:39 

AM  
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Law Type and Side. 

Deferred Entity Settings Update 14242 In new database 
ENNTYPE.SHOWLINKEDTO is NULL for 
"Other" type, therefore Show 
Employer/Parent organization checkbox is 
grayed in Entity Type DE 
Comments: When entity created with 
"Other" type, Parent Organization field is 
not shown in Entity DE 

8.7    Donatas    2/14/03 
5:22:58 PM 

Deferred General Bug 14146 Record ID should be added to the 
following listing as available column (see 
comments) 
Comments: Document Global 
Timeslips Global 
Note Global 
Groupware Global – there is Message ID 
Workflow Global 
Matter: Document listing 
Matter: Timeslips listing 
Matter: Note listing 
Matter: Groupware listing - but there is 
Message ID 
Matter: Issues 
Matter: Workflow 
Matter: Annotations 
Matter: Tree View: Sorting and Grouping 
screen - only Matter and Entity has 
Record ID 
Entity: Related Entities 
Entity: Related Tree – only Matter has 
Record ID as Available field 
Entity Merge Utility – it is called ENTITYID 
 
The folowing listings have Record ID: 
Matter Global 
Entity Global 
Matter: Entity listing 

8.7.40.1    Mike G, Ken 
F 

   2/11/03 
1:56:43 PM 
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Matter: Assign Entity wizard 
Entity: New Relationship Properties 
screen: Entity Listing 
Document Profile: Matter listing 
Document Profile: Entity listing 
Timeslips: Matter listing 
Workflow Item: Matter listing 

Deferred Groupware DE Bug 14235 Message displayed when user does not 
has access to his e-mail folders is not 
entirely correct. 
Comments: If user for some reason does 
not has access to his e-mail folders, 
message is displayed advising "…To add 
a location, click the Tools menu, click 
Services…" 
If possible, message should say that it is 
the Outlook menu where user has to click 
to correct this situation 

8.7    Donatas    2/14/03 
11:59:26 

AM  

Deferred Groupware Listing 
Query 

Update 13277 In Groupware Listing Query some of 
query fields are in all capital letters: 
BEGINTIME, CLIENTNUMBER, 
ENDTIME, MATTERNUMBER. 

8.7.38.1    Ligita    1/10/03 
3:04:58 PM 

Deferred Guideline Bug 14390 Review ability to check/uncheck "Public 
Template" checkbox on templates within 
Admin settings 
Comments: It appears that only template 
creator is able to check/uncheck Public 
Template checkbox on Groupware 
template. However, it seems like it is 
inconsistent throughout Admin settings. 
 
Matter Settings - only creator (and if not 
creator, check box not displayed at all) 
Entity Settings - only creator (and if not 
creator, check box not displayed at all) 
Documents Settings – not only creator 

8.7.40.3    Mike G    2/21/03 
2:11:26 PM 
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(with required security rights) 
Timeslips Settings - only creator (and if 
not creator, check box not displayed at all) 
Note Setting - not only creator (with 
required security rights) 
Groupware Settings - only creator (and if 
not creator, check box is grayed out) 
Workflow Settings - not only creator (with 
required security rights) 

Deferred Imageview Bug 13792 There is no Scanner. Open document with 
Image Viewer, select Scan menu> Pager, 
check any radio button and hit OK. Have 
got error screen without any text, just OK 
button. 

8.7.0.24    Rasa    1/24/03 
3:17:22 PM 

Deferred Imageview Bug 14114 Run ImageViewer without Pmwin. Enter 
Login name which not exist, hit OK, have 
got 'Invalid object names 'Entities''. 

8.7.0.24    Rasa    2/11/03 
3:48:20 PM 

Deferred Imageview Bug 14116 Run ImageViewer without Pmwin. Hit 
Cancel in Login screen, have got an 
access violation. After that ImageViewer 
runs and all buttons are enabled. 

8.7.0.24    Rasa    2/11/03 
3:48:20 PM 

Deferred Imageview Bug 14118 Rum ImageViewer without pmwin. Not 
enter anything in login screen and hit OK, 
have got 'Parameter object is improperly 
defined. Inconsistent or incomplete 
information was provided'. Hit OK, have 
got access violation. 

8.7.0.24    Rasa    2/11/03 
4:02:58 PM 

Deferred Imageview Bug 14133 Run ImageViewer without Pmwin. 
Incorrect tab order in Login screen. 
Should be 1-Login, 2-Password, 3-OK, 4-
Cancel. 

8.7.0.24    Rasa    2/11/03 
4:31:04 PM 

Deferred Imageview Bug 14135 Run ImageViewer without PM (go to 
<root>\ImgView\ and double click on 
imgv32.exe). ImageViewer connecting to 

8.7.0.24    Rasa    2/11/03 
4:41:53 PM 
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default database of SQL Server user. 
Maybe Viewer should be taken the 
connection from pmwin.udl? 

Deferred Imageview Bug 14155 OCR from Image Viewer: 
Comments: There is no Application that 
has set OCRed (Document Settings> 
Application tab> Application DE). Open 
document with Image Viewer and select 
File> OCR. Fill new created Profile DE (in 
Application field displayed the first 
Application from Document Settings> 
Application tab), click on Open Document 
button, have got ‘Cannot focus a disabled 
or invisible window’. 

8.7.0.24    Rasa    2/12/03 
10:54:53 

AM  

Deferred Imageview Bug 14222 Open document with ImageViewer. Go To 
File menu and select Close Image. 
Document is closed. Then hit on 
Next/Previous Page button. Have got 
'Login failed for user'' '. 

8.7.0.24    Rasa    2/13/03 
2:50:45 PM 

Deferred Imageview Bug 14514 From PM create document with 
ImageViewer. When Viewer window 
opens, minimize it and hit again Open 
Document button in Document Profile DE. 
Return to ImageViewer window. The 
document is closed and have got an error 
'Login failed for user'. 

8.7.0.24    Rasa    2/27/03 
1:05:53 PM 

Deferred Mail Merge Bug 13815 Mail listing screen opens with scroll bars 
Comments: Go to Tools->Mailing Lists-
>with Mailing lists tab open click New-> 
Mailing lists screen opens with scroll bars. 
It appers that this is only happning when 
you have Display Properties: Theme set 
to Win XP 

8.7.39.1    Mike G    1/24/03 
4:42:23 PM 

Deferred Mail Merge Bug 13817 Tools: Mailing Lists: Assign Lists or 
Assign Entities tabs-column headings 

8.7.39.1    Mike    1/24/03 
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should be loaded, when you open this 
listings first time 
Comments: Go to Tools: Mailing Lists -> 
click on Assign Lists or Assign Entities 
tabs. 

Girenko 5:04:33 PM 

Deferred Matter DE Feature 13971 Increase size of Matter Search Name to 
100 characters 
Comments: Shriners has a feature 
request to increase the size of the mater 
search name to 100 characters. The 
business need is listed below. 
Hi Cynthia. Below is a new procedural 
email that went out to the department from 
our Filing Dept. regarding codes they are 
having to put in the Search Name field 
primarily because of Check Logger screen 
where they have to choose Matter 001 
from to enter the asset. Please read below 
and you'll understand. I'll look for some 
examples of matters where we add 
additional info. in the Search Name and 
send them, however, this email may be 
enough for you. If you have a long matter 
name and need to further identify it, you 
have only 50 or so characters to type in. If 
it's not effecting 
anything else, could it be changed to 100?  
 
Our outside auditors require that all 
checks and wire transfers be entered into 
one Matter in PM (001 in almost all 
cases), and in Check Logger. In Check 
Logger, multiple Matters with the same 
name are shown in the field from which 
the file clerks select the Matter, but the file 
clerks cannot see the Matter Number 
(001), making it neccesary to open each 
Matter to distinguish which one is correct. 

8.7.40.1 Shriners 0209  Cynthia K; 
Mike G 

   1/31/03 
2:51:38 PM 
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To help identify the Matter a check has 
been entered into the clerks will be adding 
a "$" sign next to the Search Name to 
make it easier when the next check or 
wire transfer is received. 
Also, the file clerks enter other codes in 
the PM Search Name to help determine if 
mail goes to the Accounting Department 
or Development Department, or if a file 
has been retained in the basement. These 
include RETAIN, INCOME TRUST, IT, NO 
INTEREST, DONATIONS, RE (real 
estate), and MINERAL. A few codes you 
may be more familiar with are  
xref, aka, fka, etc. If there is not enough 
room in the Search Name, the file clerks 
enter this information in the Closed 
Number box. 
[TF 02/28/2003] This is very complex to 
implement due to the way Delphi5 
handles the field attributes in the UI 

Deferred Matter:Issues Bug 14437 1.If open issue from matter:issue tab, it is 
not matter specific. If open the same issue 
from entity:related tree tab, it is matter 
specific. 
Comments: E.g. open matter:issue tab 
and create not matter specific issue. 
Assign an entity to this issue. Close. Go to 
entity listing and open assigned entity. Got 
to Related Tree tab, expand Issues 
branch - this issue does not has 
checkmark 'Matter-Specific'. Open this 
issue DE from issue branch. In Info tab is 
checked 'Specific to this Matter'. 
 
2. If open issue from entity:related tree 
tab, then in Title Bar you not see 
description of this issue 

8.7.40.3    Rasa, Ken F    2/25/03 
11:22:44 

AM  
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[DB] This is because when opening Issue 
from Entity DE Related Tree another 
instance of Issue is created. When open 
Issue DE from Entity Related 
Tree,Specific to this matter checkbox 
should be disabled or invisible 
 
[Mike G] Per Ken F, this is priority A PCR 
and should be fixed in SP3 

Deferred Matter:Issues Update 13667 Review the matter-specific issue 
functionality 

8.7    Donatas    1/20/03 
6:54:44 PM 

Deferred Phone Call DE Bug 13740 When creating New Phone Message from 
entity global listing Phone Message DE 
form opens with no current user selected 
in the User field 
Comments: Entity global listing->right click 
and choose New Phone Call:Phone 
Message->User field is empty. 

8.7.38.1    Mike G    1/22/03 
10:48:42 

AM  

Deferred Query Bug 13749 When Query open and you choose Date 
of Birth, when you delete last digit and 
click Apply, you receive "The conversion 
of a char data type…" message 
Comments: Entity global listing->click 
Query and choose Date of Birth from drop 
down->delete last digit from the displayed 
date->click Apply-> message displayed 
Related info: if I am deleting last digit from 
Date of Birth on the Entity's Other Details 
tab and clicking Save, I am getting 
"Entered Date is not valid date in SQL 
server" 

8.7.38.1    Mike G    1/22/03 
3:30:40 PM 

Deferred System Settings Bug 13758 When time separator in system settings is 
changed to /,and I am trying to change 
time of existing Phone Call, I am getting 
"Entered date is not valid in SQL server" 

8.7.38.1    Mike G    1/22/03 
4:35:13 PM 
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error. 
Comments: Note Listing-> New Phone 
Call:Place a Call->enter required info and 
save it->go to System Setting and change 
time separator to / ->open same Phone 
Call, change time of this Call (input valid 
time) and click Save->"Entered date is not 
valid in SQL server" error shows up. 

Deferred System Settings Bug 13804 Go to System Settings > Click Date /Time 
Format Field cowboy hat button > Time 
Formatter window appears. I see Date 
Format before Time format in Time 
Format window. This should not be so - 
there must be only Time Format. 

8.7    Arunas    1/24/03 
7:21:04 PM 

Deferred System Settings Bug 14112 The matter numbering system is going 
haywire, creating matters with duplicate 
numbers since the year rolled over. LSNT 
has Matter Numbering in "Interactive" 
mode with annual recycle selected 
Comments: PM Ver. 8.6.35.4 with LSM  
Intake ver. Intsheet.exe 8.6.33.18 

8.6 LSNT  Josh Berlin 24325  2/11/03 
1:03:00 PM 

Deferred TiffView Bug 14121 Run TiffViewer without Pmwin. Enter 
Login name which not exist, hit OK, have 
got 'Invalid object names 'Entities''. 

8.7.2.23    Rasa    2/11/03 
4:22:48 PM 

Deferred TiffView Bug 14126 Run TiffViewer without Pmwin. Hit Cancel 
in Login screen, have got 'No such 
interface supported'. After that TiffViewer 
runs and all buttons are enabled. 

8.7.2.23    Rasa    2/11/03 
4:26:48 PM 

Deferred TiffView Bug 14129 Run TiffViewer without Pmwin. Enter 
Login\Password, hit OK, have got 'No 
such interface supported'. After that 
TiffViewer runs. 

8.7.2.23    Rasa    2/11/03 
4:31:04 PM 

Deferred TiffView Bug 14131 Run TiffViewer without Pmwin. Incorrect 
tab order in Login screen. Should be 1-

8.7.2.23    Rasa    2/11/03 
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Login, 2-Password, 3-OK, 4-Cancel. 4:31:04 PM 

Deferred TiffView Bug 14137 Run TiffViewer without PM (go to 
<root>\ImgView\ and double click on 
imgv32.exe). TiffViewer connecting to 
default database of SQL Server user. 
Maybe Viewer should be taken the 
connection from pmwin.udl? 

8.7.2.23    Rasa    2/11/03 
4:41:53 PM 

Deferred TiffView Bug 14224 Open document with TifViewer. Go To 
File menu and select Close Image. 
Document is closed. Then hit on 
Next/Previous Page button. Have got 
L'ogin failed for user'' '. 

8.7.2.23    Rasa    2/13/03 
3:17:21 PM 

Deferred TiffView Bug 14511 From PM create document with 
TiffViewer. When TiffViewer window 
opens, minimize it and hit again Open 
Document button in Document Profile DE. 
Return to TiffViewer window. The 
document is closed and have got an error 
'Login failed for user'. 

8.7.3.25    Rasa    2/27/03 
12:59:03 

PM  

Deferred Workflow Settings Bug 14321 Activity Type drop down list has a spelling 
error. 
Comments: Workflow Settings: Activity 
Templates tab-> open new Activity 
Template and go to Linked Actions tab-> 
click New Action->expand Action Type: 
1. "Create a Entity Record" should be 
changed to "Create an Entity record" 
2. "Create a time slip record" should be 
changed to "Create a Timeslip record" 
3. "Create a workflow record" - "Workflow" 
needs to be capitalized 
4. "Create a matter" - "Matter" needs to be 
capitalized 
5. "Create a note" - "Note" needs to be 
capitalized 

8.7.40.1    Mike G    2/19/03 
2:54:04 PM 



Printed: 03/04/2003  Last Updated: 03/04/2003 
 RealLegal, LLC Confidential and Proprietary Information 
 Project Summary Specification � Practice Manager v8.7 SP3 

C:\Documents and Settings\TFOLEY\My Documents\rl.stuff\dev\pm_core\andes\pm87sp3\specs\pm87sp3_pss_v0100.doc  
Copyright © 1992-2003 RealLegal, LLC, Rev. No. 22 Scope – Exclusions l 61 

Status Area Type ID Description/Comments Found In Site Contact Support 
Tickets Reported 

6. "Execute a program function" - 
"Program" needs to be capitalized 

Deferred Workflow Settings Bug 14456 Workflow Settings: Activity Templates tab-
Type column should be renamed to 
Category 
Comments: It is Category, if you look on 
Activity Template or look on Workflow 
Global listing 

8.7.40.3    Mike G    2/25/03 
4:51:49 PM 
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8. Project Organization 

The project described by this document falls into the standard category of a software deliverable.  The project 
is organized into three levels of responsibility.  The product level, program level, and project level.   

At the project level the schedule and day to day details of the project are managed by a Project Manager.   The 
responsibility of the primary deliverable (the software program) is managed by a Program Manager.   The 
responsibility of the product suite to which the program will be part of, the programs relationship within that 
suite, and external material such as marketing, application support, and client relations are managed by the 
Product Manager.   

The typical workflow of a software deliverable starts with the Product Manager scheduling a kick-off meeting 
with the primary participants in order to discuss requirements, issues, and product strategy.  If the decision is 
to undertake the project then a Subject Matter Expert constructs a Functional Requirement Specification 
(FRS) to communicate the goals of the project be it a new undertaking or an update of an existing program.  
The purpose of the FRS is to ask "what" needs to be included and "why".  It will not describe "how" a 
particular item will be implemented nor can it be viewed in terms of a project.  The product of the (FRS) may 
encompass multiple projects spanning several release cycles and several years. 

The assigned Program Manager then coordinates with the Subject Matter Expert in constructing a Program 
Summary Specification (PSS).  When the inclusions, exclusions, estimated resources,  estimated budget, 
estimated duration, and preliminary plan have been approved the Functional Design Specification (FDS) is 
produced in order to communicate "how" an item will be functionally implemented.   

The Program Manager will coordinate with other resources at his/her disposal in order to clarify the project to 
the Project Manager and Project Lead.  The Technical Analyst and Quality Assurance Manager are two such 
resources that are available to the Program Manager.  A Technical Design Specification (TDS) developed by 
the Technical Analyst may be required of some projects in order to communicate the suggested architecture, 
data model and technical solution to the developers.  The technical review process is important in order to 
keep consistency in the product suite. 

The Program Manager then coordinates with the Project Manager to schedule resources for a project kick-off 
meeting at which time the project plan can be viewed as a reliable estimate.  When the Lead Developer 
completes the coding process the program is turned over to Quality Assurance as many times as necessary to 
root out all A, B, and C bugs which correspond to the level of quality required for an (A)lpha, (B)eta, and 
(C)ertification cycle release. 

At the conclusion of the certification cycle the program can be released to the Product Manager which will 
oversee training and distribution. 

 

9. Roles / Responsibility 
 

Position / Project Role Participant / Person Project Responsibility 

Product Manager Ricky Huszagh 
rickyhuszagh@reallegal.com 

• Review and comment on project 
deliverables. 

• Monitor project progress.  

Subject Matter Expert Not Applicable • Functional Requirement Specification. 
• Review and comment on project 

deliverables. 
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Program Manager Tom Foley 
tfoley@reallegal.com 

• Review and comment on all project 
deliverables. 

• Project Summary Specification. 
• Functional Design Specification. 

Project Manager Tom Foley 
tfoley@reallegal.com 

• Review and comment on  project 
deliverables. 

• Project Plan 

Graphic Design Lead Tom Foley 
tfoley@reallegal.com 

• Functional Design Mockups 

Quality Assurance Manager Ken Fusco 
kfusco@reallegal.com 

• Test Plan 

Technical Analyst Saulius Kundrotas 
saulius@pmt.lt 
Darius Kirna 
darius_k@pmt.lt 

• Review and comment on  project 
deliverables. 

• Technical Design Specification 

Technical Writer Tom Foley (Release Notes and Install) 
tfoley@reallegal.com 
Cynthia Hobday 
chobday@reallegal.com 

• User Manual, Install Guide, Release 
Notes 

Lead Developer Saulius Kundrotas 
saulius@pmt.lt 

• Review and comment on  project 
deliverables. 

• Turnover to Quality Assurance 

Lead Quality Assuror Donatas Barakauskas 
donatas@pmt.lt 

• Review and comment on  project 
deliverables. 

 

10. Scope Management 

The functional scope of the project is finalized when the FDS is certified.  A functional feature that is not 
specified before the certification of the FDS will not be included unless the Product Manager certifies the 
inclusion and the Project Plan is updated.  This scope creep is allowable if a situation arises that requires the 
inclusion in order to meet customer demand or satisfy a strategic purpose.   

If a functional item is generated from one of the following statements without meeting any higher purpose 
then it does not qualify to be included: "wouldn't it be nice if we added this", "we did that so why not this 
too..." or "it does that but it would be better if it did this instead".   

At each stage of development reasons for scope creep work their way into a program primarily because 
foreseeing all options is a difficult if not impossible task.  However, in order to meet deliverables, stay on 
budget, and within the given timeline some functional requests must be deferred or discarded permanently. 

A different form of scope creep is technical scope creep.  Technical decisions and architecture can often 
impact the duration of a project and in some cases can be viewed as providing functionality to the program.  
These decisions often cannot be made at the time that the functional feature set is locked down and therefore 
are permissible and expected to some extent. 

 



Printed: 03/04/2003  Last Updated: 03/04/2003 
 RealLegal, LLC Confidential and Proprietary Information 
 Project Summary Specification � Practice Manager v8.7 SP3 

C:\Documents and Settings\TFOLEY\My Documents\rl.stuff\dev\pm_core\andes\pm87sp3\specs\pm87sp3_pss_v0100.doc  
Copyright © 1992-2003 RealLegal, LLC, Rev. No. 22 Scope Management l 64 

11. Scope Management 

The risk to this project has been quantified based on the estimated project duration of [xx] days described 
later.  The reader may use the last column of the following table in order to rank each risk by its total impact 
on the project.  The project should be planned around the top 20% of the risks listed in the following table.  
Using this rule the most critical decision for planning this project is [....] 

 

ID Risk Effect Mitigation Probability Impact Exposure 

1 Number of PCRs to be 
inlcuded in the release 
increases. 

Coding and testing time 
will be increased. 

 75% Unknown Unknown 

       

       
 

12. Issue Tracking Management 

Any issue that arises during the course of the project must be routed to the Program Manager along with 
possible resolutions.   The Program Manager will coordinate with the available resources in order to resolve 
the issue and will notify the Project Manager of any slippage in the schedule that will result.  If the issue 
cannot be resolved then an alternative solution will be presented to the Product Manager if that solution 
effects the functionality that was certified at the onset of the project. 

 

13. Quality Review Management 

Certified functional items will be entered into the internal tracking system at the onset of development.  Any 
item originating from scope creep will be entered into the internal tracking system at the moment the item is 
certified.  Quality Assurance will enter items during the test cycle phase.  Any item that hinders the 
functionality of the program without a possible workaround is assigned (A) priority and must be resolved 
before the product can enter beta phase.  An item that hinders functionality of the program but is able to be 
worked around is assigned  (B) priority and must be resolved before the product can enter the certification 
phase.  An item that does not hinder the functionality of the product is assigned (C) priority and must either 
be resolved before the product is certified or deferred to a later release. 

 

14. Monitoring Mechanisms 

The Team Leader or Lead Developer if the Team Leader is absent is responsible for communicating all issues 
to either the Project Manager or Program Manager depending on the nature of the issue and for delivering a 
status report at the conclusion of each week.   The Project Manager is responsible for communicating 
slippages to the Program Manager at least twice a week.  The Program Manager is responsible for 
collaborating with all available resources and giving a status report to the Product Manager once each week.   

 

Mechanism From To Frequency 

Status Report Team Leader / Lead Developer Program Manager Every Friday 

Predicted Issue Report Team Leader / Lead Developer Program Manager Conclusion of Alpha 
Development 

Project Report Project Manager  All Every Tuesday  

Status Report Program Manager Product Manager and Product 
Manager Internal 

Every Wednesday 
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Mechanism From To Frequency 

Phase Review Program Manager Subject Matter Expert Conclusion of Alpha 
Development 

Turnover Notice Team Leader / Lead Developer All Conclusion of Cycle 
Development   

Published Notice Project Manager Program Manager QA Acceptance of a Turnover 
 

15. Deliverables 

The project is divided into multiple stages and multiple phases.  The term phase is used to describe a portion 
of the project cycle as well as the division of functionality among multiple releases.  In the following table the 
term phase represents a portion of the project and not a release.  This plan covers only the tasks required to 
complete this release. 

 

Phase Stage Responsibility Deliverable(s) 

Product Manager • Project Proposal / Meeting 
• Needs Requirement 

Subject Matter Expert • Functional Requirement 
Specification 

Program Manager • Project Summary 
Specification 

Technical Analyst • Technical Impact 

Planning Phase Program Initialization 

Practice Manager Program 
Manager 

• Impact Assessment 

Program Manager • Functional Design 
Specification 

Functional Design 

Quality Assurance Manager • Test Environment Design 
& Plan 

Analysis Phase 

Technical Design Technical Analyst • Technical Design 
Specification 

• Data Model 

Project Initialization Project Manager • Resource Allocation  
• Development Plan 

Coding Lead Developer • Source code & compiled 
code 

• Predicted Issue Report 

Testing Quality Assurance • Issue Report 

Development Phase 

Conclusion Program Manager • Project Post-Mortem 
 

16. Project Plan 

The following links to the external Microsoft Project 2000 Project Plan. 

http://pm.reallegal.com/reallegal/download/rd/schedules/current_development_scheduled.html 
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17. High-Level Project Plan 

The following table outlines the high-level milestones developed for this release of Practice Manager v8.7 
SP3 (phase one).  The exact dates will not be known until the development schedule is produced. 

 

ID Phase / Stage Duration Days In Planned 
Finish 

Slippage Actual 
Finish 

1. Planning 5 days  03/05/2003   

2. Analysis N/A N/A N/A N/A N/A 

3. Initialization N/A N/A N/A N/A N/A 

4. Alpha Coding and Testing N/A N/A N/A N/A N/A 

5. Beta Coding and Testing 32 days  04/22/2003   

6. Acceptance 8 days  04/28/2003   

7. Availability Announcement 1 day  04/29/2003   

8. Orientation 1 day  04/30/2003   
 

A shell detailed project file is available at the following link: 

http://pm.reallegal.com/reallegal/download/rd/schedules/rl.pss.schedule.mpp. 

 


